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A Reasons for Amendment

Paragraph 442 has been amended to provide guidance on:

DDORS access
report status
reporting timeframes
action items

user roles.

Paragraph 444 has been added to provide guidance on DDORS organizational updates.

Exhibit 35 has been withdrawn because the process has been automated (Exhibit 36).

Exhibit 36 has been added to provide guidance on completing DD FLP oversight reports.
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Par. 441
Section 2 DD FLP Oversight

General Provisions

A

Overview

It is incumbent upon DD’s to monitor the FLP delivery in Service Centers to ensure
adherence to appropriate laws, policies, and procedures.

Purpose

The DD FLP oversight process provides a standardized and consistent reporting format and
means by which DD can:

e document results from quarterly FLP oversight reviews
e view previously completed quarterly reports
e monitor and followup on actions to be taken by FLP Service Center staff.

DDORS

A

Overview

Reporting of FLP oversight reviews will be completed on a quarterly basis. DDORS is the
official record documenting the results of the quarterly reviews.

DDORS:

e was developed to assist DD with completing FLP oversight reviews conducted in the FLP
Service Centers online

e provides the means by which DD can document and submit review results to State and
Field Offices electronically

e contains the review items for each reporting quarter
e*--archives oversight reports for five FY’s.
System Access

Access DDORS from the Farm Loan Programs Systems Home Page, located at
https://amistad.sc.egov.usda.gov/flp/IndexServlet.

DDORS may also be accessed at
https://wdcprod80.sc.egov.usda.gov/Ddors/homepage.aspx.

Note: See Exhibit 36 for detailed instruction on accessing DDORS.--*
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Par. 442

DDORS (Continued)

*--B  System Access (Continued)

2-3-14

Users who need access to DDORS should contact their State DDORS Administrator. The
authentication and authorization of users is made using USDA’s eAuthentication application.

To access DDORS users must have the following:

e valid eAuthentication ID and password
e eAuthentication Level 2 account
e authorized access by the DDORS Administrator.

Report Statuses

Report Status will be as follows:

e “Archived”, Service Center closed during FY

e “Not Started”, the report is empty and can only be accessed by DD

e “In Progress”, the report is partially completed

e “Submitted”, the report was completed and certified before its due date

e “Auto-Submitted”, the report was not certified before its due date. The report may be
partially completed or empty.

Note: “Submitted” and “Auto-Submitted” reports cannot be modified; however, pending
action items can be followed up and closed.

Service Center Progress Reports

Progress reports provide counts of “Not Started”, “In Progress”, “Submitted”, and
“Auto-Submitted” oversight reports that are in the State and in each district.

Reporting Timeframes--*
The first quarter report:

e will be available for completion in DDORS starting November 1 and ending on
January 31

e should reflect first quarter data gathered between October 1 and December 31

e is comprised of quarterly review items, additional review items, and certification.
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Par. 442
442  DDORS (Continued)

*--E Reporting Timeframes (Continued)--*
The second quarter and first semi-annual report:
e will be available for completion in DDORS starting February 1 and ending on April 30
e should reflect:

e second quarter data gathered between January 1 through March 31 for quarterly
review items

e data gathered between October 1 through March 31 for the first semi-annual review
items

e is comprised of quarterly review items, first semi-annual review items, additional review
items, and certification.

The third quarter report:

e will be available for completion in DDORS starting May 1 and ending on July 31

e should reflect third quarter data gathered between April 1 and June 30

e is comprised of quarterly review items, additional review items, and certification.

The fourth quarter, second semi-annual, and annual report:

e will be available for completion in DDORS starting August 1 and ending on October 31

e should reflect:

e fourth quarter data gathered between July 1 and September 30 for quarterly review
items

e data gathered between April 1 and September 30 for the second semi-annual review
items

e data gathered between October 1 at the beginning of FY through September 30 at the
end of FY to complete the annual review items
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Par. 442
442  DDORS (Continued)

*--E Reporting Timeframes (Continued)

e is comprised of quarterly review items, second semi-annual review items, annual review
items, additional review items, and certification.

Notes: The quarterly report that corresponds to the current reporting period will be displayed
when DD selects the link for the Service Center to be reviewed from the DDORS
Home Page.

Results for all review areas corresponding to each quarter will be captured when the
report is submitted or auto-submitted by DDORS when the reporting period has
ended.

Oversight reports are locked when DD submits the report or after the due date.
DDORS does not allow anyone to add, modify, or delete review information.

F Action Items

An action item is a note attached to a review area, a review record, or a review item in an
oversight report. Action items allow users to document concerns and issues about oversight
reviews.

DD’s are highly encouraged to use action items to bring awareness to the Service Center and
State Office, of problems and deficiencies discovered during the oversight review.

Only DD or proxy assigned to an oversight report can add action items to and close action
items in the report. DD or proxy can add an action item anytime before submitting the
report.

After an oversight report is submitted or auto-submitted, any DDORS user who can view a
report can also followup on action items in the report by adding their own comments. Users
can add followup comments to an action item until it is closed by DD or proxy.

Follow this table to add comments to a pending action item.

Step Action
1 |Go to the review area, review record, or review item with the pending action item.
CLICK “ ™ Faollow up pending action item"'
CLICK *“Add Follow-Up Comments”.
Enter followup comments in the box.
CLICK “Save Follow-Up”.
CLICK “Save Follow-Up”.

SOOI IW| N
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Par. 442

442  DDORS (Continued)

*.-G User Roles

There are 6 user roles, as follow. User’s role will be displayed under “DDORS Menu”,
under user’s name.

Example: If user is an administrator, then “Administrator” will be displayed under “DDORS

2-3-14

Menu”, under user’s name.
National User Role

National users are DAFLP, Assistant DAFLP, Directors, Deputy Directors, FLPRA
review teams, and national administrators. A national user role allows users to:

e view in progress, submitted, and auto-submitted oversight reports for all Service
Centers

o followup pending action items in submitted and auto-submitted reports by adding
followup comments.

For all States, national administrators can:
e manage:

e proxy assignments

e specialist assignments

e UuSer accounts

e assign user roles in 1 State to another State.

Example: DD in Maryland needs to manage a district in Delaware. National
administrator can make the assignment.--*
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442  DDORS (Continued)

*--G User Roles (Continued)
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State User Role

State users may include SED’s, FLC’s, FLS’s, COR’s, or State administrators. A State
user role allows users to:

e view-only, in progress, submitted, and auto-submitted oversight reports for specified
Service Centers

o followup pending action items in submitted and auto-submitted reports by adding
followup comments

e act as a proxy for DD, if assigned

e act as specialist, if assigned to a Service Center.

State administrators:

e can activate or deactivate user accounts

e can assign and manage proxy and specialist assignments

e are limited to assigning user roles for Service Centers and districts within their State.
District User Role

DD’s are assigned by the State administrator:

e to the districts that he or she manages

e read-only access to oversight reports from another district, as determined by the State
Office

e afloating DD role to act as a proxy for other DD’s.
A district user role allows users to:
e complete and edit oversight reports for their Service Centers

e add action items to their oversight reports
o followup and close pending action items in their reports.--*
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442  DDORS (Continued)

*--G User Roles (Continued)
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Service Center User Role
Service Center user role allows users to:
e view submitted and auto-submitted oversight reports for their Service Center

o followup pending action items in submitted and auto-submitted reports by adding
followup comments.

Proxy User Role
Proxy user’s:

e are temporarily assigned to a Service Center to manage its oversight reports
e can complete, certify, and submit oversight reports for the assigned Service Center
e can followup and close the assigned Service Center’s action items.

Proxy assignments are terminated if DD’s district assignment changes or if DD or
proxy’s account is inactivated.

Note: During the time period a proxy is assigned to a Service Center, DD can view, but
cannot edit, the Service Center’s oversight reports.

Specialist User Role

Specialist users are State users who are assigned to work on a Service Center’s oversight
report along with DD or proxy. Specialist users can add and modify review information
anywhere in the oversight report.

Specialist users cannot:

e delete review records added by others
e add new action items or close existing action items
e certify (sign) or submit oversight reports.--*
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Par. 443
443  Responsibilities

A DD Responsibilities

*--See Exhibit 36 for detailed guidance on completing the oversight report online and creating
various Hyperion and GLS reports.--*

DD’s shall:

e coordinate and plan all FLP oversight review site visits with FLP State Office staff so
that participation by FLC or FLS can be arranged when necessary

e notify SED and FLC of any apparent problems that may require immediate attention
o*--use DDORS to:

complete reviews for each Service Center quarterly

document specific findings for each case file or operational file reviewed

record and followup on any noted problems or inconsistencies as an “Action Item”
submit completed Service Center oversight reports.

Note: Submitting the report online in DDORS is the:

e certification for that report
e DD’s signature.--*

B Service Center Responsibilities
Service Center staff shall:

e*--assist as needed with items to be reviewed--*
e Dbe available to discuss specific cases or to answer questions from DD
e followup on any action items identified by DD’s in DDORS.
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Par. 443

Responsibilities (Continued)

C State Office Responsibilities

SED’s shall ensure that timely FLP oversight reviews are completed by DD’s in DDORS.
FLC’s shall:

e assign a State System Administrator for DDORS

o*--review quarterly reports submitted--*

e followup on any identified action items

e discuss concerns with DD and SED

o*--document the actions taken to remedy identified deficiencies in the operational file.--*

National Office Responsibilities

DDORS oversight reports shall be reviewed with the FLPRA process. Reports for each FLP
Service Center within a State shall be reviewed to ensure that:

e consistent oversight reviews are being conducted by DD’s in the State

e SED’sand FLC’s are monitoring and addressing any deficiencies or apparent problems
identified by DD’s.
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Par. 444
*--444 DDORS Organization Updates

A About Organization Updates

The MRT database is the system of record for all organizational data in DDORS. State
Offices must submit FSA-2125 to FLOO to add, delete, or move Service Centers and/or
districts. These changes are processed in the PLAS database that populates MRT.

Each Tuesday evening, DDORS searches MRT for changes. Any changes found will flow
into DDORS and become organization updates.

DDORS automatically generates an e-mail to the State DDORS administrator when changes
have been found, alerting the State DDORS administrator that the pending changes are ready
for review and acceptance. The e-mail includes a hyperlink to the DDORS Organization
Updates Screen for quick and easy access.

'Home | About DDORS | Help | Contact Us | Exit DDORS | Logout of eAuth

Organization Updates

State: | v| & Help

Available Updates

On Wednesday, August 07, 2013, the organization of service centers in your state changed. You
can accept the changes to DDORS service centers.

Review & Accept the Organization Updates 2

The number of organization changes by type:

Number of Organization Updates

Additions Deletions Moves Mame Changes
1 1 0 0

The State administrator must click “Review & Accept the Organization Updates” link and
accept the pending changes in DDORS before any changes are made to the Service Centers
and/or districts in DDORS.--*
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*--444 DDORS Organization Updates (Continued)

2-3-14

B Accepting Organization Updates

Follow this table to review and accept organization updates changes.

Step

Action

1

From DDORS Home Page, under “Menu”, CLICK “Organization Updates”.

2

From “State” drop-down list, select a State if user has access to more than 1 State.

IF organizational updates are... |THEN the...

available “Available Updates” section will be displayed.

not available “Current DDORS Organization Structure”

section will be displayed.

If “Available Updates” section is displayed, CLICK “Review & Accept the
Organization Updates” link.

In the table, review the highlighted changes to Service Centers and districts.

If changes within a district require a new DD assignment:

in the second column, CLICK “Change the DD link for the district
select another DD or the “Absent District Director” option and CLICK “Save”.

If displayed, CLICK “Users currently assigned to the Service Center” link to
determine which, if any, users are affected and need to be reassigned.

If users need to be reassigned, do the following:

print the user assignment information on the “Users currently assigned to the
Service Center” window

using the “User Management” module that is accessed by clicking “Home”
button at the top of the page and then under “Menu”, clicking “User
Management”, find and modify the user accounts.

CLICK *“Accept Organization Updates” to accept the changes.

Important:  Users cannot undo organization changes after they have been accepted.

DDORS cannot revert back to an earlier organization structure.--*
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Reports, Forms, Abbreviations, and Redelegations of Authority

Reports

Reports
Control Reporting Negative
Number Title Period | Submission Date| Reports |Reference
FLP4 FLPRA Annual Annually |By February 1 Required 403
Report each year
Forms
This table lists all forms referenced in this handbook.
Display
Number Title Reference | Reference
CCC-10 Representations for Commodity Credit Corporation Ex. 36
or Farm Service Agency Loans and Authorization to
File a Financing Statement and Related Documents
CCC-257 Schedule of Deposit Ex. 36
FmHA 2006-21 | Information Systems Management (ISM) Request 52
for Changes to User Documentation
FSA-13-A Data Security Access Authorization Form 53, 54, 166,
Ex. 15, 36
FSA-137 Address Information Request 46
FSA-159 Request for Supplies, Forms, and/or Publications Ex. 17
FSA-470 Tractor Feed Post Card for Metered Postage 46
FSA-603 Collection Register for State and County Offices Ex. 36
FSA-851 Environmental Risk Survey Form Ex. 36
FSA-2001 Request for Direct Loan Assistance 44,47, 48,
Ex. 36
FSA-2007 Statement Required by the Privacy Act for 48
Non-Applicants
FSA-2028 Security Agreement Ex. 36
FSA-2037 Farm Business Plan Worksheet Balance Sheet Ex. 15
FSA-2038 Farm Business Plan Worksheet Projected/Actual Ex. 15
Income and Expense
FSA-2040 Agreement and Record of the Disposition of FSA 262, 263,
Security/Release of Proceeds Ex. 7, 36
FSA-2065 Annual Statement Loan Account 49, 52
FSA-2072 Cancellation of U.S. Treasury Check and/or 169
Obligation
FSA-2101 DD FLP Oversight Report Guide Ex. 36
FSA-2103 Direct Loan Making File Review Questionnaire 28
FSA-2104 Guaranteed Loan Making File Review Questionnaire 28

2-3-14

This table lists the required reports of this handbook.

Exhibit 1
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Reports, Forms, Abbreviations, and Redelegations of Authority (Continued)

Forms (Continued)

2-3-14

Exhibit 1

Display
Number Title Reference | Reference
FSA-2119 | Delinquent Borrower Servicing File Review 28
Questionnaire
FSA-2120 |Moratorium Notice 41
FSA-2121 | Termination of Moratorium 41
FSA-2125 |Farm Loan Program County Information File Changes 46, 444
FSA-2126 |Program Loan Cost Expense (PLCE) Request 162,
(Non-Contractuals only) 166-169
FSA-2127 |Request for CED FLP Loan Approval Authority 25
FSA-2139 |Notification of Exemption From Requirement to 102
Provide Social Security Number
FSA-2140 |Deposit Agreement 101, 102,
Ex. 15, 36
FSA-2141 |Interest-Bearing Deposit Agreement 102
FSA-2142 | Statement of Deposits and Withdrawals 103, Ex. 36
FSA-2144 | Designated Financial Institution Pledge of Collateral 102
FSA-2145 | Demand for Withdrawal of Supervised Bank Account 103
Funds
FSA-2150 |Development Plan 122,125
FSA-2153 |Release by Claimants 122
FSA-2154 |Release by Contractor 122
FSA-2160 |Appraisal of Chattel Property 142
FSA-2161 | Appraisal Report - Agricultural Tract 142
FSA-2162 |Real Estate Sales Data 142
FSA-2163 |Supplemental Forms-Agricultural Appraisal 142
FSA-2164 | Appraisal for Mineral Rights 142
FSA-2165 | Administrative Appraisal Review 143
FSA-2166 |Technical Appraisal Review and Certification 143
FSA-2167 |Administrative Appraisal Review for Chattel 143
Appraisals
FSA-2171 | Substitute Invoice 167, 169
FSA-2172 |Request for Emergency Payment 169
FSA-2173 |Foundation Financial Information System (FFIS) 166, 167
Vendor Code Request
FSA-2198 1/ |Claimants With Closed Settlement Claims With No Ex. 13.5
Appeal Hearing in Suspension
FSA-2199 1/ | Claimants With Closed Settlement Claims With Appeal Ex. 13.5
Hearing in Suspension
FSA-2201 |Lender’s Agreement 47
FSA-2211 | Application for Guarantee 44, 47
1/ Contact Jenny Breece at 202-720-4572 to obtain FSA-2198 and FSA-2199.
1-FLP (Rev. 1) Amend. 94 Page 2



Reports, Forms, Abbreviations, and Redelegations of Authority (Continued)

Forms (Continued)

2-3-14

Exhibit 1

Display
Number Title Reference | Reference
FSA-2212 |Preferred Lender Application For Guarantee 44, 47
FSA-2232 | Conditional Commitment 43, EX. 7
FSA-2235 |Loan Guarantee Ex. 7
FSA-2242 | Assignment of Guarantee Ex. 7
FSA-2292 |Guaranteed Loan Processing Checklist Ex. 36
FSA-2301 |Request For Youth Loan 44, 47, 48,
Ex. 15
FSA-2304 |Notice of Incomplete Application Ex. 36
FSA-2305 |Second Notice of Incomplete Application Ex. 36
FSA-2306 |Notice of Application Withdrawal/Pending Withdrawal Ex. 36
FSA-2307 |Notice of Complete Application Ex. 36
FSA-2308 |Notice of Eligibility for FSA Assistance Ex. 36
FSA-2311A |Emergency Loan Calculations Ex. 15
FSA-2313 |Notification of Loan Approval and Borrower 202
Responsibilities
FSA-2314 | Streamlined Request for Direct OL Assistance 48
FSA-2330 |Request for Microloan Assistance 44, 48
FSA-2341 | Certification of Attorney 43
FSA-2342 | Certification of Title Insurance Company 43
FSA-2510 |Notice of Availability of Loan Servicing to Borrowers 3
Who Are 90 Days Past Due
FSA-2512 |Notice of Availability of Loan Servicing to Borrowers 3
Who Are Current, Financially Distressed, or Less Than
90 Days Past Due
FSA-2514 | Notice of Availability of Loan Servicing to Borrowers 3
Who Are in Non-Monetary Default
FSA-2535 | Conservation Contract 3
FSA-2543 |Shared Appreciation Agreement 3
FSA-2544 | Request for Information on Capital Improvements Ex. 36
FSA-2545 | Borrower Notification of Shared Appreciation Due Ex. 36
OF-347 Order for Supplies and Services 165
RD 1922-15 | Administrative Appraisal Review for Single Family 143
Housing
RD 1940-22 |Environmental Checklist for Categorical Exclusions Ex. 15, 36
SF-1449 Solicitation/Contract/Order for Commercial ltems 165

1-FLP (Rev. 1) Amend. 94
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Exhibit 1

Reports, Forms, Abbreviations, and Redelegations of Authority (Continued)

Abbreviations Not Listed in 1-CM

The following abbreviations are not listed in 1-CM.

Approved

Abbreviation Term Reference

ACCP accelerated payment 169

ACIF Agricultural Credit Insurance Fund 163

ADR alternative dispute resolution 42

ARRA American Recovery and Reinvestment Act of 2009 28, 163, EX. 16

AS Agricultural Specialist 23, 26, Ex. 7

BIR Business Information Report 48

BPA Blanket Purchase Agreement 161, 162, 165, 166

BOPR Borrower Property Table 166

CCR Central Contractor Registration 162

CDAT Consent Decree Action Team Ex. 12, 13.5

CL conservation loan Text, Ex. 2, 15, 16

CMT Constant Maturity Treasury Ex. 17

CNC currently not collectible 41, 251, Ex. 5,12, 13,
13.5, 15

CONACT Consolidated Farm and Rural Development Act 1,21, 29,142, 251

CPA Certified Public Accountant Ex. 26

DDORS District Director Oversight Reporting System 442,443, 444, EX. 2, 36

eDALR$ electronic Debt and Loan Restructuring System Ex. 13.5, 15, 17

DUNS Data Universal Numbering System 43

ECM Enterprise Content Management 5, 52

EIN employer identification number 53

ERSR Electronic Repository of Security Requests 53, Ex. 15

FAR Federal Acquisitions Regulation 162, 165, 166

FCAO Farm Credit Applications Office 49, Ex. 15

FHP Farm and Home Plan Ex. 5, 15

FLOTRACK |Farm Loan Officer Trainee Tracking System 25

FLPRA Farm Loan Programs Risk Assessment 401-403, 443, Ex. 36

FmHA Farmers Home Administration 52, ExX. 5

FMMI Financial Management Modernization Initiative 162-169

ISA installment set-aside Ex. 15

ITLAP Indian Tribal Land Acquisition Program 2, Ex. 16

2-3-14
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Reports, Forms, Abbreviations, and Redelegations of Authority (Continued)

Abbreviations Not Listed in 1-CM (Continued)

Exhibit 1

Approved

Abbreviation Term Reference

LOA Loan Analyst 23,26, Ex. 7

LOC line of credit 29, Ex. 15, 16

LR limited resource 223, 261, 263,
Ex. 15, 16

LRS Loan Resolution Specialist 23, 26, Ex. 7

MADS margin after debt service Ex. 15

ML microloan 222,242, Ex. 15, 16

MRT Master Reference Table 444

OA Office of Adjudication 41

OTI Opportunity to Improve Plan 25

PAC Program Authority Code 162, 164, 167

PARLC, LAO |Policy, Accounting, Reporting, and Loan Center, Loan |169

(FFIS Team) |Accounting Office

PIP Performance Improvement Plan 25

PLP Preferred Lender Program 29, 43,143, Ex. 5

PLS Primary Loan Servicing 25, 27, 29, 42, 144,
Ex. 5, 36

RCI recoverable cost items Ex. 15

SALP Special Apple Loan Program 2,29

SAM System for Award Management 43, 166

SEL standard eligible lender 25, 43,143,
Ex. 5, 36

SLR Security Liaison Representative 53, Ex. 14,15

TC transaction code 46, 49, 50, 52, 164,
Ex. 14

TDCLC term debt capability lease coverage 252, Ex. 15

TY payment voucher transaction 167-169

WEM Web Equity Manager Ex. 15

YEA year-end analysis 162, 201, 251,
261-263, Ex. 15,
26, 36

ZMY Obligating document or purchase order created in FMMI. | 167-169

Redelegations of Authority

SED’s may redelegate their:

e |oan approval authority to FLC, FLS, or DD

e authority to allow the use of a restricted appraisal report to the designated State staff

appraiser.

2-3-14
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Menu and Screen Index

The following menus and screens are displayed in this handbook.

Exhibit 3

Menu or

Screen Title Reference
Classification Review Workflow Report Screen Ex. 36
Complete/Approved Application file reviews Screen Ex. 36
DDORS Home Page EXx. 36
Direct Application Report Selection Page Ex. 36
Farm Loan Programs Data Mart/Direct Loan System (DLS) OnDemand |EX. 36
Reports/Loan Making Reports/Direct Applications Screen
Farm Loan Programs Data Mart/Direct Loan System (DLS) OnDemand |EX. 36
Reports/Loan Making Reports Screen
Farm Loan Programs Data Mart/Direct Loan System (DLS) OnDemand |EX. 36
Reports Screen
Farm Loan Programs Data Mart/Program Loan Accounting System Ex. 14
(PLAS) OnDemand Reports/SCIMS to PLAS Screen
Farm Loan Programs Systems Home Page Ex. 36
Farm Loan Programs Systems Main Menu Ex. 36
Farm Loans Programs Data Mart Screen Ex. 36
Farm Visit Workflow Report Screen Ex. 36
FLP - Risk Assessment Screen Ex. 36
FSA Applications Screen Ex. 14, 36
FSA Data Warehouse Home Page Ex. 14, 36
FSA Data Warehouse Production Home Page Ex. 14, 36
FSA Intranet Home Page Ex. 14, 36
GLS Farm Loan Application Package List Screen Ex. 36
GLS Farm Loan Application Package View Screen Ex. 36
GLS Farm Service Agency Reports Screen EXx. 36
GLS FSA GLSAPPO2 - Guaranteed Loan Applications Detail Screen Ex. 36
GLS Guaranteed Loan System & CBP Direct Loans and Grants Screen Ex. 36
GLS Guaranteed Loan System Screen Ex. 36
Graduation Review Monitoring Report Screen Ex. 36
Lending To Beginning Farmers and Ranchers - Goal 4 Screen Ex. 36
Limited Resource Review Monitoring Report Screen Ex. 36
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Menu and Screen Index (Continued)

Exhibit 3

Menu or

Screen Title Reference
Organization Updates Screen 444
Outstanding Subordination Report Screen Ex. 36
Print Options Screen Ex. 36
Reduce 1st Year Delinquency Rate on New Loans by 25% Over 5 Years |EX. 36
Screen
Reduce Average Processing Times for Direct Loans - Goal 2 Screen Ex. 36
Report Outline Screen Ex. 36
SCIMS to PLAS Update Screen Ex. 14
Search Criteria Screen Ex. 36
Service Center Review Scoring Ex. 36
Shared Workspace Pages/HomePage Ex. 14, 36
Socially Disadvantaged Farmers and Ranchers - Goal 5 Screen Ex. 36
Subordination Request Report Screen Ex. 36
Year End Analysis Workflow Report Screen Ex. 36
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Exhibit 36

(Par. 442, 443)
DD FLP Oversight Review User Guide (Continued)
Table of Contents

A DIDORS ACCESS ...ttt ettt ettt ettt bt e s bttt e e a e e e ahe e e R b e e b e e e R e £ e eRe e oAbt e Rt e eRRe e ehe e eR bt e eEe e ene e e nbeeenneennee s 4
L VI AACCESS. .. ittt ettt ettt sttt ettt s e bttt s e e bt ekt e s et e E e R e e R e R e Re e Rt e Rt e R e e R beeRe e Re et e eneenreente e 4
2 Accessing DDORS ONlNE REPOI.......ccuiiiiiieie ettt et re e te e e e e sre e sreenee e 6
3 PIINT REPOI ACCESS. ...ttt etttk b ket b bbbt b bt bt bt e se et e b et bt ebe b e e bt eneennas 7
A HEIP AACCESS ..ottt ettt ettt ettt et s e et et e et e e Rt e te e s e e Re et e n e e e Re e Reente Rt e bt enaenreeareeneeaneenres 8
B Online GUIAES @Nd REPOIT.........ciieieiieiie ettt e e e e teene e re e teaneesraenreeneenres 10
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2 FLP Data Mart (Data IMAIT) .......ccveieiieieiiesee ettt sttt sneennesneennes 11
I o Y (LT To A L 7 o -SSR 12
C Oversight Review General INfOrmation.............cccveiiiiiiiiii i 15
1 Accessing DDORS ONlINE REPOM .......ccuviiiiieieiie sttt st ae e nne s 16
2 ACCeSSING DIreCt LOAN REPOIS .......eiuiiiieiiiieiesiesie sttt bbb 17
3 Accessing Guaranteed LOan REPOIS .......ccviieeiiiieieeie et se et te e ste e re e sneesre e nns 19
D Part A: QUANTEITY REVIEW ........ouiiieiic ettt ettt et e e e nneeneennes 28
1 “Direct Loan Making: Review of Direct Loan AppliCations”...........ccccevveviiiienieeresieeseeseseesneas 28
A “Complete/Approved Application File REVIEWS” ... 28
B “Incomplete Application File REVIEWS” ........ccviiieiiiie ettt 29
C “Withdrawn Application File REVIEWS ..........ooiiiiiiiiieieesie e 30
D “Rejected Application FIle REVIEWS .........ccuiiieiieiiee sttt 31
2 “Guaranteed Loan Making: Review Of Guaranteed Loan Applications™ .........c.cccevvvvvvrverirnenne. 32
3 “DIrect Loan SETIVICINE™ .....iiiiiiiiiiiieiiiiie ittt e stee e st et e st e e e e s sbb e e s sbb e sbb e e abe e e st e e e snbeeenrneeennes 33
A “Delinquent ACCOUNT SETVICING ....ccuiiriiiiiiiiiiiieiie ettt 33
| “Borrowers With Loans 90 Days Or More Past DUE”...........cccceviviiiiiiiiiin i 33
Il “Borrowers With Loans Less Than 90 Days Past Due” ...........ccccooviieiiiicniciiicnee 38
11 “Borrowers With Loans That May Require Attention”.........ccccovvvvrriveeinieesieeesiieeesieeennns 42
B “Payments AN COLLECTIONS™ .......ouiiiiirieitirieitieiie ettt b bbbt sb e 43
C  “Chatte]l Security ACCOUNTINE” ... .uiiiiiieiiiieiieiesieeesieeesieessree e e sbeessrreesbeeesbeessbeeessseeennes 45

4 “Program Delivery FLP Goals: From FLP goals established by the National Office for your
] 721 (<SPS OUPSRSSPR 43
E Part B: SEMIannuUal REVIBWS........c.ooiiiiieieiieie et e et te e saeeneesteesteaneesneenneeneennes 57
1 Direct Loan Making: Loan Security INSITUMENTS ..........coerireiireiinesceee e 57
P B | = To o o T 1= V7 o] 1 Vo PSR PRTR 59
A Shared ApPreciation AQIEEIMENTS .........cceririiiiririei ettt bbbt seeneas 59
B Classification 0f BOITOWEr ACCOUNTS.........cciuiiiiiieiieie ettt sre e e 61
C YA ENG ANAIYSIS ..ttt bbbt 67
3 Guaranteed LOAN SEIVICING........ciiiiie ettt ettt ettt et e ae e b e s nbe e beeenaeesaeeaneas 70
A Semiannual and Default Status Reports and Delinquent Loan ACCOUNES...........c.ccovrevreennnn. 70
B LENABT REVIBW ...ttt b ettt et et st e b e et e reenbe et e 73
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(Par. 442, 443)
DD FLP Oversight Review User Guide (Continued)
Table of Contents (Continued)
F o Part C: ANNUAI REVIBWS ..ottt b ettt e et et sbeenteeneenres 74
1 DIreCt LOAN SEIVICING ...cuvitiitiitiitieiieit ettt bbbttt b et bbbt 74
A BOITOWET GratUALION ......o.viiviiiiiiieiieie ettt bbbttt bbb beeneeneeneas 74
[ ST o] £ [ -4 0] USRS 78
C Chattel SECUrity ACCOUNTING ......ciuviieiieieeiesee st et e ste et e e ee s e s teeaesreesreeneesnaennes 81
D Limited RESOUICE REVIEWS ......ocuieiiieiiiiieiiieiesiiesiee et este e sseesteeseesteesteentesneesbeeaesneesseenee e 86
A e (o To =T A =] [V o S 88
A SUPEIVISEd BANK ACCOUNTS ..ottt bbbt 88
2 I e (0T T Ly T €] 10101 o o SR 89
G Part D: AddItIONal REVIBWS..........ciiiiiieieieiie ettt ettt ettt ne s e 90
1 “Farm Loan Program Risk Assessment (FLPRA) REVIEWS™ ........cccccveeiieeiiiiiesiere e seesie e 90
2 “County Operations REVIEWS ........c.ciiiiiiiiiiieiiiii et 93
H Part E: Certification District DIreCtor SIgNatUIE .........ccoceiieiiiieiieesie e e 93
I Example of Completed OVersight REPOIT.........ccociiiiiiiece e 94
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Exhibit 36
(Par. 442, 443)

DD FLP Oversight Review User Guide (Continued)

This guide:

e isaresource to assist in completing the online oversight report

¢ identifies the electronic direct loan making and servicing reports available from Data Mart, along
with the guaranteed loan making and servicing reports available in GLS

e follows the order of the online oversight report

e provides step-by-step instructions when deemed necessary.

Paragraphs 441 through 444 address all issues of reporting timeframes, user roles and responsibilities,
and distribution of reports.

A DDORS Access

1 Web Access

DDORS authorized users can access DDORS using Microsoft Internet Explorer 7.0+ by either of
the following:

e Internet at https://wdcprod80.sc.egov.usda.gov/ddors/homepage.aspx
e Intranet, as follows.

Step

Action

1

To access DDORS, go to the FSA Intranet at
http://fsaintranet.sc.egov.usda.gov/fsa/ and on the FSA Intranet Home Page, under
“Resources”, CLICK “FSA Applications”.

FSA Intranet

Resources In the Spotlight  Archive )

2-3-14
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Exhibit 36

(Par. 442, 443)

DD FLP Oversight Review User Guide (Continued)

A DDORS Access (Continued)

1 Web Access (Continued)

2-3-14

Step

Action

2

From the FSA Applications Screen, under “Farm Loan Programs”, CLICK “Farm
Loan Programs Systems”. Log in with eAuthentication user ID and password, or

LincPass and PIN.

Search

Links
FSA Applications

[ FSA Applications and programs

FSA Applications

Common Applications

* Preview the new Personalized Applications Page

Conservation

Other Related Links

« CARS - Crop Acreage « Biomass Crop Assistance
Reporting System Program (BCAP)

« Common Payment Reports + Cost Share Software (CSS)
System + Program Provisioning

« eForm (Employee site to Conservation Funds Ledger
process eForms) System (CFLS)

Fiduciary + Conservation On-Line
Comprehensive Information System

Management Systems Conservation Payments
(CIMS) CRP Soils Database

+ RLMS (eRep) Management System
« RLMS Report (eRep) « Emergency Forestry CRP
« Farm Records « Grassland Reserve Program
« ICAMS )
« Fed Traveler +« HELC/Wetlands Program
« FSA Data Marts + TIP Payment Process
«» LRA Site(Identity Proof a
customer) Farm Loan Programs

+ Modernize and innovate the
Delivery of Agricultural

Systems (MIDAS) » Farm Loan Programs Systems

From the Farm Loan Programs Systems Main Menu, under “Other FLP Systems”,

CLICK “District Director Oversight Reporting System (DDORS)”.

eDALRS

Farm Business Plan
Guaranteed Loan
System

Reports

Risk Assessment
(FLPRA)

Other FLP Systems
State Directive

System
(SDMS)

GLS Electronic Funds
Transfer Block (GEFTB)

Farm Loan Officer
Trainee Tracking
System (FLOTRACK)

District Director

Applications Farm Loan Programs Systems Main Menu
Direct Loan System

Welcome to the Farm Loan Programs (FLP) Systems.

Thus 15 your centrakized Farm Loan Programs (FLP) Systems, After all s
operational, you will be able to make and service your chents' applicat]
this site. It has been designed to streamhbine the overall process of m3
portfolios by eliminating the need to input the same data mto multiple]
ncorporate direct knks and system interfaces into other systems to re
errors, Tt will allow for all levels of reporting from a central location.

Questions and comments about the site can be referred to the FLPS V

If you have any issues with the performance of these applications, thy
to the Help Desk.

ST

1-FLP (Rev. 1) Amend. 94
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Exhibit 36
(Par. 442, 443)
DD FLP Oversight Review User Guide (Continued)

A DDORS Access (Continued)
2 Accessing DDORS Online Report

DD’s can access the online report DDORS for the Service Center being reviewed, from the
DDORS Home Page, by selecting the Service Center name.

Oversight reports can be viewed by authorized users as soon as the DD or proxy begins adding
information. Follow this table to view previously submitted reports.

Step Action

1 |Select Home in the menu at the top of the page, if not already on the Home Page.

2 |Inthe menu on the left, indicate the reporting period by using the “Fiscal Year” and
“Quarter” drop-down lists. Use the “State” drop-down list to select the applicable State,
if user has access to more than 1 State. CLICK “Go”.

Owversight Reports

2013 v
Third Quarter w
Alabama “

3 |From the list of all Service Centers that will be displayed, select a Service Center with a
report status of “In Progress”, “Submitted”, or “Auto-Submitted”” and select the
“Service Center” name.

2-3-14 1-FLP (Rev. 1) Amend. 94 Page 6



DD FLP Oversight Review User Guide (Continued)

Exhibit 36
(Par. 442, 443)

A DDORS Access (Continued)

3 Print Report Access

Follow this table to view or print the report.

Step

Action
1

First Quarter
FY 2012 Report

Report Outline

The report was submitted on 1/30/2012

Quarterly Review Items

Direct Loan Making

Complete/Approved Applications - 5 Complete Records

Incomplete Applications - 2 Complete Records

Withdrawn Applications - 3 Complete Records

Rejected Applications - 2 Complete Records
Guaranteed Loan Making

Guaranteed Loan Applications - 4 Complete Records
Direct Loan Servicing

Loans 90 Days or More Past Due - 5 Complete Records
Loans Less Than 90 Days Past Due

Loans That May Reguire Attention - 10 Complete Records
Payments and Collections - 5 Complete Records

- 17 Complete Records

Chattel Security Accounting - 5 Complete Records

Program Delivery

4
% Printer-Friendly /

FLF Goals - 1 Complete Record
Report

Additional Reviews

Certification

The full report can be viewed on screen or printed at any point after the report has been
initiated. From the Report Outline Screen, CLICK “Printer-Friendly Report”.

& veip

»

4
AR

The Print Options Screen will be displayed. Select the areas of the report to view and
CLICK “Continue”.

USDA United States Department ol Agncullure
Zamll Farm Service Agency DDORS

Print options

[ print Review Areas

[ Print Comments

[C] Print Action Items

5 All Action Items
Open Action Items
Closed Action Items

[

o Printing Tips

# If your printed reports do not include shading as shown in the print preview, it is because the Print
background colors and images option in Internet Explorer is not selected.

To include shading in your printout:
1.

2.
3. Inthe Printing section, select the Print background colors and images check box.
4. Click OK.

On the Tools menu (in Internet Explorer), click Internet Options.
Click the Advanced tab.

& To change or remowe the information in the header and footer of your printouts or to adjust the page

margins, on the File menu, click Page Setup. All page margins must be set to less than 0.75 inch to print
oversight reports properly.

1-FLP (Rev. 1) Amend. 94
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Exhibit 36
(Par. 442, 443)
DD FLP Oversight Review User Guide (Continued)

A DDORS Access (Continued)

3 Print Report Access (Continued)

Step Action
3 [When FSA-2101 is displayed, users may view on screen or CLICK “Print”.

[~ print " print options[§ Close Window |

Report Generated On: 8/5/2013

FSA 2101 U.S. Department of Agriculture
Farm Senvice Agency

DD FLP OVERSIGHT REPORT GUIDE
Third Quarter Report
For Reviews Completed for the Period of 4/1/2013 through 6/30/2013.
(District Director should complete this review before 7/31/2013.)
1.STATE 2.DISTRICT NUMBER 3.SERVICE CENTER 4.FISCAL YEAR
D-01 2013

Part A. Quarterly Review 1. Direct Loan Making : Review Of Direct Loan Applications
A. Complete/Approved Application File Reviews

1. Applicant Name

Applicant representation is consistent within all FSA programs (Applicant has not applied for or received
Agency benefits under any other name, entity or identification number)

Applicant was notified of receipt of complete application

Applicants were notified within 5 days of an eligibility determination

Appropriate environmental assessment completed

If application was held over 45 days without a loan decision, was a reason entered in DLS?

N

NIgvi e

Credit decision (approval) was made within 60 days of receipt of complete loan application

4 Help Access

DDORS has a “Help” function that is available throughout the online report, as displayed on this
example DDORS Home Page.

USDA United States Department of Agriculture D Do Rs

— .
=l Farm Service Agency District Director Oversight Reporting System

About DDORS | Help | Contact Us | Exit DDORS | Logout of eAuth

DDORS Menu 2013 Fourth Quarter

The District Director should complete reviews before 10/31/2013. OHelp

0.00% of service center reports nationwide have been Submitted. ;
0.00% of service center reports in AL have been Submitted. More Information

2-3-14 1-FLP (Rev. 1) Amend. 94 Page 8



Exhibit 36
(Par. 442, 443)
DD FLP Oversight Review User Guide (Continued)

A DDORS Access (Continued)
4 Help Access (Continued)

The following is an example of the screen that will be displayed with topics for assistance.

Contents [RediT=FT()1

What's New?
[7] What's New?

I’i’] About DDORS This to!:ric provides an overview of features added to the District Director Oversight
Iﬁ DDORS User Roles Reporting System (DDORS).
[#] What is a proxy?
[Z] What is a specialist?
|7 Frequently Asked Questions
< Oversight Reports
+ %Actiun [tems
- Managing Proxies (for Administ

m

Version 1.6 m

Importing (Copying) Record Names from Previous Reporting Periods

When filling out reports, in some review areas you can import record names from
previous reporting periods.

-8 Managing Specialists (for Admii FLP Goals Data Pre-Filled

* @ Managing User Accounts (for A In the =econd, third, and fourth quarter reports, the Service Center Goal values in the

R Managing Organization Updates Program Delivery, FLP Goals review area are automatically filled with the value entered
I'ii] Log out of DDORS during the previous reporting period.

Annual Direct Loan Servicing Data Pre-Filled

2-3-14 1-FLP (Rev. 1) Amend. 94 Page 9



Exhibit 36
(Par. 442, 443)

DD FLP Oversight Review User Guide (Continued)

B Online Guides and Reports

1 User Guides

On the Farm Loan Program Systems Home Page, under “Information Links”, if users CLICK
“Manual”, the following user guides will be available:

e DLS-Loan Making User’s Guide

e DLS-Loan Servicing User’s Guide, that includes:

e Direct Loan System training
e Special Servicing Reference and User Guide

Hyperion Reports User Guide

e GLS-Guaranteed Loan System User Guide.

SDA United States Departmant of Agnculture
=

FSA - Farm Loan Programs Systems :

¥

| FSA Intranet Home | About USDA | Help | Contact Us

ALERTS

Informational Links

AUTOMATED SYSTEMS

#
f If you have any technical issues with the performance of any of these applications,

Farm Loan Programs Systems

Welcome to the home page for the Farm Loan Programs (FLP) Systems.

This site is your portal to the secured web-based systems: Direct Loan System,
eDALRS, Farm Business Plan, Guaranteed Loan System, Reports, and FLP Risk
Assessment. Use the Logon button on the left for access.

This site and the related web pages will be evolving as we develop and expand with
new features and new software capabilities.

please contact the Help Desk at 1-800-255-2434.

Exhibit 14 provides details about how to create SCIMS-PLAS ORACLE Hyperion Reports.

2-3-14
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Exhibit 36
(Par. 442, 443)
DD FLP Oversight Review User Guide (Continued)

B Online Guides and Reports (Continued)
2 FLP Data Mart (Data Mart)
Hyperion access is required to have Data Mart access. Users who do not already have access to
Data Mart must complete FSA-13-A and submit it to the appropriate Security Liaison

Representative.

The following example displays how, on FSA-13-A, users should complete the “Hyperion” and
“Other/Comments” sections, as highlighted, to request access to Data Mart.

E D Environment: E FProduction D Development D Certification
Datamart (Group): FLE Data Mart eAuth
For FSA_CORE and Financial Web Applications Data Marts(FWADM) Only:
D Federal users table (list federal Org codes): MITC
[ state users table (list states):

|:| County users table (list counties):

Z0—MU<I

Please contact Datamart owner for assistance. See ASA/Application Approver on Page 3.
https:/ffsadwhouse. sc.egov.usda.gov/FSA-DataMarts/FSAdataMartsHomePage . html

Other/Camments:
Flease grant access to environment: Production Oracle Hyperion EFM for the requested user with authorization to
Hyperion Group "FLP Data Mart"

Note: In the “Other/Comments” block, ENTER “Please grant access to environment:
Production Oracle Hyperion EPM for the requested user with authorization to
Hyperion Group “FLP Data Mart”.

2-3-14 1-FLP (Rev. 1) Amend. 94 Page 11



Exhibit 36
(Par. 442, 443)
DD FLP Oversight Review User Guide (Continued)

B Online Guides and Reports (Continued)
3 Hyperion Database

The following is a quick review of how to access Data Mart reports needed for completing
DDORS. This information can also be found in the Hyperion Reports User Guide.

Step Action

1 |From the FSA Intranet Home Page, under “Links”, CLICK “FSA Applications” and
the FSA Applications Screen will be displayed.

Under “Common Applications”, CLICK “FSA Data Marts”.

D o AbaO i o 00 elp D d O e Phone ployee 0 atio
FSA Home > FSA Applications

FSA Applications

mﬂ!* Preview the new Personalized Applications Page

Common Applications

Conservation

Other Related Links .

CARS - Crop Acreage
Reporting System

Common Payment Reports
System

eForm (Employee site to
process eForms)

Fiduciary

Comprehensive Information

Management Systems
(CIMS)

RLMS (eRep)

RLMS Report (eRep)
Farm Records

ICAMS

Fed Traveler

FSA Data Marts €
LRA Site(Identity Proof a

Biomass Crop Assistance
Program (BCAP)

Cost Share Software (C55S)
Program Provisioning
Conservation Funds Ledger
System (CFLS)
Conservation On-Line
System

Conservation Payments

CRP Soils Database
Management System

Emergency Forestry CRP

Grassland Reserve Program
(GRP)

HELC/Wetlands Program
TIP Payment Process

customer) Farm Loan Programs
- L .
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Exhibit 36
(Par. 442, 443)

B Online Guides and Reports (Continued)

3 Hyperion Database (Continued)

Step Action

2 |On the FSA Data Warehouse Home Page, CLICK “Oracle EPM 11 Data Marts”.

Log in with eAuthentication user id and password, or LincPass and PIN to proceed.

FSA=S

Data Warehouse News and Updates

I
Tﬁllerfs Click here to view planned or unexpected changes/outages/alerts

= = Read Important Information for:

FSA has now completely upgraded to the Hypenon reporting »

t00. Brio has been disabled. Hypenon software should have 3

been installed on vour PCs. Please click on the link titled States that use FSA State ‘County Data Mart
Navigation through Hypenon' on the nght for mstructions to Federal Non-Federal Financual Reports

access a data mant

States and Laree Offices using all other Data Mant

Hyperion will have a different look from the Bao Web page Reports
data marts, the reports themselves have not changed. General

NOTICE! thas area from time to time. Please refer to this screen often.
niering an Officsl

U Stat ormme
Crrepenpeeeapse PO Click on the ink to the nght titled Hypenon Data Marts' and
provide your Eauth Id and password to enter Hypenon

mformation that apphies to all data marts may be displayed m Nawgating through Hypenon

Hyperion Data Marts

# Oracle EPM 11 Data Marts *—-—

Workspace”.

Link FSA Data Warehouse Production Home Page

link on the left to proceed.
new features and new software capabilities.

3642

2-3-14 1-FLP (Rev. 1) Amend. 94

3 |On the FSA Data Warehouse Production Home Page, under “Links”, CLICK “EPM

| FSA Intranet Home | AboutUSDA | Help | ContactUs |

Welcome to the home page for the FSA Data Warehouse Production Home Page.

This site is your portal to the FSA Production Data Warehouse. Use the EPM Workspace

Informational Links This site and the related web pages will be evolving as we develop and expand with

If you have any technical issues, please contact the ITS Help Desk at 1-800-457-
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Exhibit 36
(Par. 442, 443)

B Online Guides and Reports (Continued)

3 Hyperion Database (Continued)

Step Action

4 | On the Oracle Screen tool bar, CLICK “Explore”.

E Oracle Enterprise Performance Management Syst...

p File View Favorites Tools Help
S i e Explore E Ei

neu:nﬂyt)pemd
f=

T

T

2-3-14
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Folders 1| # hame & |Type ot
[ Farm Loan Pragrams Data Mart E: Fakder NN 328 PH
+| [ Farm Loan Programs Data b... [ F5a Siate and County Salary and Expense Data Mart Folder 419112 5:08 P
+| [£] F5A Sigte and County Salar [ FADM Ciats Mart Falder 101512 £:20 P
+| [ FWADM Data Mart 7 Shared Warkspnce Pages Folder B0 11:43 AN
({7 Snored Workspocs Pages
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(Par. 442, 443)

DD FLP Oversight Review User Guide (Continued)

B Online Guides and Reports (Continued)

3 Hyperion Database (Continued)

Step

Action

6

On the

e “Direct Loan Systems (DLS) OnDemand Reports”, both direct loan making and

loa

Note: Information from these reports will be used to complete parts of the

e “Goal OnDemand Reports”, information needed to complete the direct loan making
goals section of the oversight report will be provided.

: File View Favorites Tools Help

A & bBgbe | B @

Farm Loans Programs Data Mart Screen, under “Folders”, if users click:

n servicing reports will be displayed

oversight report.

JFarm Lean Programs Data Mart
Folders 1 | *|Name
=| [ Root [ Direct Loan System (DLS) OnDemand Reports
| [ﬁ] Direct Loan System (OLS) OnDemand Reports [fj Guaranteed Loan System (GLS) OnDemand Reports
+| [] Loan Making Reports *_'_—- [£7 Information
#| [[J Loan Servicing Reports +——— [ OnDemand Reports
[f] Mizcellaneous Reports [fj Program Loan Accounting System (PLAS) OnDemand Reports
[] Goal OnDemand Reports g [] Reports
[ﬁ] Guaranteed Loan System (GLS) OnDemand Reportzs [ﬂ Scheduled Jobs

[] Information
[] OnDemand Reports

d| E! Program Loan Accounting System (PLAS) OnDemand Re... I

C Oversight Review General Information

Online Data Mart and GLS reports should be created in advance of the Service Center visit. DD can
begin the oversight review by using the reports to complete sections of the online report in DDORS,
from any location, to maximize time spent in the Service Center.

2-3-14
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Exhibit 36
(Par. 442, 443)
DD FLP Oversight Review User Guide (Continued)

C Oversight Review General Information (Continued)
1 Accessing DDORS Online Report

Access the online report from the DDORS Home Page and select the Service Center name.

Step Action
1 |On the Report Outline Screen, select the hyperlink for the desired section of the report.

Home | About DDORS | Help | Contact Us | Exit DDORS | Logout of eAuth

Second Quarter Report Outline
FY 2013 Report

Sections denoted with * are included with the Second Quarter report. gHeID

* Quarterly Review Items

Direct Loan Making """

Complete/Approved Applications - 6 Complete Records

»

Incomplete Applications - 0 Records
Withdrawn Applications - 4 Complete Records
Rejected Applications - 4 Complete Records

Guaranteed Loan Making *-——______.

Guaranteed Loan Applications - 1 Complete Record

Direct Loan Servicing

Loans 90 Days or More Past Due - 0 Records

2 | The questions are answered online within DDORS.

| [Home|About DDORS |Help|Contact Us| Exit DDORS]

second Quarter

2013 Report Complete/Approved Application file reviews

Quarterly Review 9 Direct Loan Making 2 Direct Loan Applications 0 Hel
<% Complete/Approved Application file reviews P

= Review Area Record: 1. - -

Applicant Name (Required)

Applicant representation is consistent within all FSA programs (&pplicant has not applied for or
received Agency benefits under any other name, entity or identification number)

v Yes
No
Applicant was notified of receipt of complete application

v es
No

Applicants were notified within 5 days of an eligibility determination

"(Yes
No

% Appropriate environmental assessment completed

v es
MNo
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Exhibit 36
(Par. 442, 443)
DD FLP Oversight Review User Guide (Continued)

C Oversight Review General Information (Continued)
2 Accessing Direct Loan Reports

Access the direct loan reports from Data Mart. This following report will provide information
needed for all 4 direct loan making review items.

Step Action

1 {On the Farm Loan Programs Data Mart/Direct Loan System (DLS) OnDemand Reports
Screen, under “Name”, CLICK “Loan Making Reports”.

“m He View Favortes Tools Help

WV oA tee g0 b

{Farm Loan Programs Data MartDirect Loan System (DLS) OnDemand Reports

Falders 1| 4 Name 4 [Type Modifed

-] [ Roat [ Loan Waking Repuns(-—-— Falder 113013 3:09 M
= [E] Farm Loan Programs Data Mar [[j Loan Servicing Reports Folder I3 328 PN

2 | On the Farm Loan Programs Data Mart/Direct Loan System (DLS) OnDemand
Reports/Loan Making Reports Screen, under “Name”, CLICK “Direct Applications”.
f” File ‘View Favorites Tools Help
W oA tee g | b
{Farm Loan Programs Data Mart/Direct Loan System (DLS) OnDemand Reports/Loan Making Reports
Folders 1| #|Name & [Type | o i
-] {7 Roat [ﬁjDirectAppIicatiuns*—-—-——" Folder 48139:01 AW
=| [["J Farm Loan Programs Data Mar lf:] Obligations Folder 1014112 2:55 PN
3 | On the Farm Loan Programs Data Mart/Direct Loan System (DLS) OnDemand

Reports/Loan Making Reports/Direct Applications Screen, under “Name”, CLICK OY
FLPDM Direct Application Report.

” Fle View Favorites Tools Help
W 4 B % Explore B | S 1
fFarm Loan Programs Data Mart/Direct Loan System (DLS) OnDemand Reports/Loan Making Reporis/Direct Applications
Folders 1] #[name Type Modified Dest
5 ﬁl Root ﬂl 0% FLPOM Borrower Training Report Interactive Report...  1/30/13 3:09 PM
= [E] Farm Loan Programs Data Mar || oY FLPOM Direct Application Dispostion Interactive Report... 11/2211 417 PN
- [D Direct Loan System (DLS) ﬂl 0 FLPOM Direct Application Report *_.—-—-—— Interactive Report... 11/2211 417 PN
5 [ﬂ Lean Making Reporis || O FLPDM Direct Applications 60Day Tracking Interactive Report... 11/22M11 4:17 PH

2-3-14
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DD FLP Oversight Review User Guide (Continued)

Exhibit 36
(Par. 442, 443)

C Oversight Review General Information (Continued)

2 Accessing Direct Loan Reports (Continued)

Step

Action

4

On the Direct Application Report Selection Page, select:

e State

e district

e servicing office

e county, as follows:

e all counties
e specific county.

The report can be run by FY or by specific date range. There are numerous sort options
for the report, with up to 4 sort criteria possible, and the report can be run in 4 different

formats. Excel format allows further sorting capability.

Direct Application Report Selection Page

Selection Criteria:
State:

District 4/ Senicing Office:

Hold the CTRL or SHIFT key down for Multiple Selections

County:

<===5elect State==>> - All Districts  |JiF8 All Service Offices All Counties
Alabama 501 01-305 Tuscaloosa 01-001 Autauga
Alaska 502 01-308 Elmore 01-002 Baldwin
Arizona 503 01-309 Coffee 01-003 Barbour
Arkansas Sl A04 S 01-311 | awrenre S 01-004 Rihh
Ethnicity: Status: Race: Gender:
° N_‘ ) - All Races - All Genders
’ Hlspamc Approved Amer Indn/Alsk Naty Female
' Mon-Hispanic Rejected - Asian - Male

2013

-] @ Date by Fiscal Year

List Borrowers

~» Date by Range‘\

by Days ReviElig

by 1st Disp Date.

by Days Cmp/1st Disp
by Final Disp Date

by Oblig Date

by Close Date

by Days Oblig/Close
by Loan Amt Req

by Loan Amt Apr

by Loan Type

2-3-14

by TOA

by Final Disp ffe———

1-

FLP (Rev. 1) Amend. 94

Report Selection Report Format:
|state Report ] @ PDF Format
Sort Selection: = B
by 557 1D# .] @ Ascendm.g -~ Print
» Descending §

by SS# |D# 1 Hyperion Format
by Name @ Ascending
by Race/Ethniticy ) Descending
by Gender _ _ Run Report
by Carryover < (ST, ResetAll
by App Recv Date 1_._ . Descending

by App Cmp Date
by Days ReviCmp
by Elig Date
by Elig Det
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Exhibit 36
(Par. 442, 443)

DD FLP Oversight Review User Guide (Continued)

C Oversight Review General Information (Continued)
3 Accessing Guaranteed Loan Reports

Access guarantee loan reports from GLS. The following report will provide a portion of the
information necessary to complete the guaranteed loan making review items.

Step Action
1 |On the Farm Loan Programs Systems Main Menu, under “Applications”, CLICK
“Guaranteed Loan System”.

| FLPS Home | About USDA | Help | ContactUs | Logout of eAuth

Applications Farm Loan Programs Systems Main Menu
Direct Loan System

- Direct Loan Making

- Direct Loan Servicing Welcome to the Farm Loan Programs (FLP) Systems.
eDALRS _ This is your centralized Farm Loan Programs (FLP) Systems. After all systems are operational,
Farm Business Plan vou will be able to make and service your clients' applications and loans from this site. It has
Guaranteed Loan System|_been designed to streamline the overall process of managing your clients' portfolios by
Tarans ipinating the need to input the same data into multiple systems. It will incorporate direct

3 link d system interfaces into other systems to reduce the chance of errors. It will allow for
Risk Assessment all leve aporting from a central location.

(FLPRA)

Other FLP Systems Questions and comments about the site can be referred to the FLPS Web Team.
State Directive If vou have any issues with the performance of these applications, they must be referred to
:‘:[;‘:Eg;’me“‘ System the Help Desk.

2 |GLS is shared with RD that makes it necessary to CLICK “Welcome to the Farm
Service Agency” icon on the GLS Guaranteed Loan System & CBP Direct Loans and

Grants Screen.

SD United States Department of Agriculture ‘
m Guaranteed Loan System & CBP Direct Loans and Granis

GLS FSA RBS RHS RUS
Home Home Home Home Borrower Lend

J:t.J' ‘1‘t

Farm Service Agency

C——
B
Guaranteed Loan System is available for use

Monday through Saturday from 6am to Tpm
Central Daylight Time and Sunday from Sam
to dpm.

Rural Business-Cooperative Service Rural Utilities Service

2-3-14 1-FLP (Rev. 1) Amend. 94 Page 19



DD FLP Oversight Review User Guide (Continued)

Exhibit 36
(Par. 442, 443)

C Oversight Review General Information (Continued)

3 Accessing Guaranteed Loan Reports (Continued)

Step Action

3 |On the GLS Guaranteed Loan System Screen, CLICK “Reports”.

(CONNITET L

GLS
Home

FSA
Home

Borrower Lender

=) GLS Guaranteed Loan System

Loans

Reports

Application Paclkkage List

Application Package Add

Loan Guarantee Reguest Add

Loan Guarantee Reguest Update

Loan List
Administrative Fee/Treasury Rate List
FSA NAICS List

FSA Integrator/Contractor List

Reference Table List

GLS 1099C Control Dates
Eeports *

Forms

GLS MRE

|

On the GLS Farm Service Agency Reports Screen, CLICK “Expand All SubMenu
Option Lists” link and the list will expand to show all the available GLS reports.

GLS

Home Home Borrower

Expand All SubMenn Option Lists <+

=~ —— GLS Farm Service Agency Reports

MOTICE: Data onthe Reports is dowmnloaded on a nightly hasis. TH

Lender

FSA Reports
Ad Application Reports

A  Activity Reporis

2-3-14 1-FLP (Rev. 1) Amend. 94
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Exhibit 36
(Par. 442, 443)

DD FLP Oversight Review User Guide (Continued)

C Oversight Review General Information (Continued)

3 Accessing Guaranteed Loan Reports (Continued)

2-3-14

Step

Action

5

The GLS Farm Service Agency Reports Screen will be redisplayed with an expanded
list of reports. Under FSA Reports, “Applications Reports”, CLICK
“GLSAPP02 - Guaranteed Loan Applications Detail Report”.

The report will be displayed with lender, borrower, and application information for each
application that matches the specified search criteria.

=————= GLS Farm Service Agency Reports

GLS FSA

Home Home Borrower Lender L

HOTICE: Drata onthe Reports 15 downloaded on a nightly basis. Therefore, the data w

#  Expand All SubMenu Option Lists

FSA Reports

A8 Application Reporis

GLSAPPO2 - Guaranteed Loan Applications Detail Report <t
GLSAPPO] - Guaranteed Loan Applications Summary Report
GLS52208 - Guaranteed Loan Average Processing Times

GLS2209 - Guaranteed Loan Application Tracking Summary Report
GLS2209A - Guaranteed Loan Application Tracking Detail Report

1-FLP (Rev. 1) Amend. 94 Page 21



Exhibit 36

(Par. 442, 443)

DD FLP Oversight Review User Guide (Continued)

C Oversight Review General Information (Continued)

3 Accessing Guaranteed Loan Reports (Continued)

Step Action

Detail Screen, do the following:
e for a specific county, from the:

e “Geographic State” drop-down list, select State

specific county
e Dby Service Center select:

e “Servicing State” drop-down list, select State

Service Center

e make a selection from the “Process Date” drop-down list

6 |To create the report, from the GLS FSA GLSAPPO02 - Guaranteed Loan Applications

e CLICK “List Counties” and from “List Counties” drop-down list, select a

e CLICK “List Offices” and from “All Offices” drop-down list, select applicable

=— —— GLS FSA 6LSAPPO? - Guaranteed Loan Applications Detail

Search Criteria

Lender ID Branch List
Integrator Lookup

Integrator lij Select -

A1l Offices
MONRCEVILLE 01 317
MONTGCMERY 01 300

2-3-14 1-FLP (Rev. 1) Amend. 94

Process Date Zpplications Received

Home Home Add Application Borrower Lender Loans Reports

Specify Search Criteria fo restrict the contents of the report to entries which match your specifications.

NAICS Code
Category Select -
Desm'ption Select -
Type Select = /
Geographic State ALRERMA "+ Bl Counties - [ List Counties I
Servicing State ALRBAMA ~ R11 Offices - List Offices e

Forms

Page 22



Exhibit 36
(Par. 442, 443)

DD FLP Oversight Review User Guide (Continued)

C Oversight Review General Information (Continued)

3 Accessing Guaranteed Loan Reports (Continued)

2-3-14

Step Action
6 |e select the date range for the report with the “From” and “To0” options
(Cntd)

e use “Sort” drop-down lists to select the way the report will display.

Note: To view the report by oldest guaranteed applications, sort by
“Date Application Received”.

CLICK “Submit Query”.
From January * 01 - 2013 (e.g.:EUDD}TO March v 31 - 2013 (e5.2
Emvironmental Review Type 211 -

Sort Options

Specify Sort Option to control the order in which selected entries are displayed on output rep)

Sort Applicant/Borrower Name v| Ascending Order -
Applicant/Borrower Name

Approved Lender ID and Branch

Date Application Received

Date of Cbhligation

Geographic 5tate and County

Loan Type

Race

Servicing State and COffice

Repthonnﬂ: Formatted |Environmental Review Type ne -

Lender Status

Integrator

Submit Query I I Reset Form

rt Format" from the drop down list; Select a delivery ribution is selected.); Select " Sub

1-FLP (Rev. 1) Amend. 94 Page 23



Exhibit 36
(Par. 442, 443)
DD FLP Oversight Review User Guide (Continued)

C Oversight Review General Information (Continued)

3 Accessing Guaranteed Loan Reports (Continued)

Step Action

7 | The Guaranteed Loan Applications Detail Report will be used to select the applications
to review. The following example was selected by State and a Service Center, and was
sorted by date range and name.

CAC204 United States Department of Agriculture 11/06/2013

GLSAPP02 FARM SERVICE AGENCY 06.16.55
/ Guaranteed Loan Applications Detail Report Page: 2

Applicant Name ™ Geo St Cnty

Approved Lender Borrower ID  Mail Code Date Rec'd Date of Final Action Envr Review

Integrator Race Loan Type Date Cplt Disposition Date Date Cmpl Amount

WHITE, JOE 01036 111111111 01308 01072013 APPROVED OBLIGATED CATEX $430,000.00

LOCAL FARMCREDIT WHITE FO 01102013 01102013 011412013 01102013

BLUE, SAM 01086222222222 (01308 01/072013 APPROVED OBLIGATED CATEX §9,546.00

SMALL TOWN BANK WHITE oL 01102013 01102013 011412013 01102013

LOCAL FOODS

8 [Application information by borrower can also be found on the GLS Farm Loan
Guarantee Request View Screen. To access the GLS Farm Loan Guarantee Request
View Screen, from the GLS Guaranteed Loan System Screen, CLICK “Application
Package List”.

(NI L

= GLS Guaranteed Loan System

GLS FSA
Home Home Borrower Lender Loans Reports

Application Package List

Application Package Add

Loan Guarantee Request Add

Loan Guarantee Request Update

Loan List

Administrative Fee/Treasury Rate List
FSA NAICS List

FSA Integrator/Contractor List

2-3-14 1-FLP (Rev. 1) Amend. 94 Page 24



Exhibit 36
(Par. 442, 443)

DD FLP Oversight Review User Guide (Continued)

C Oversight Review General Information (Continued)

3 Accessing Guaranteed Loan Reports (Continued)

2-3-14

Step

Action

9

The GLS Farm Loan Application Package List Screen will be displayed. Access the
GLS Farm Loan Guarantee Request View Screen for a specific application by either of
the following and CLICK “Submit”:

e “applicant ID”
e “applicant name” and “State”.

SIA G6LS Farm Loan Application Package List
“-
: GLS Home | FSA Home | List Applications | Add Application | Add Reguest | Bomower | Lender | Loans | Reports | Forms | Help

Search by
@ Applicant ID {Random ID/Account Number)
_) Applicant Name/State L1l States
_) Lender
Lender ID * Branch =
Submit Reset I ID Cross Reference I

10

The GLS Farm Loan Application Package List Screen will be redisplayed with an
“Action” drop-down list. To view applications, using the “Action” drop-down list,
select “View Application Package” and CLICK “Submit”. The GLS Farm Loan
Application Package List Screen will be redisplayed with a list of applications. CLICK
“Received Date” link for the appropriate loan.

SIDA 6LS Farm Loan Application Package List
: GLS Home | FSA Home | List Applicaticns | Add Applicstion | Add Reguest | Bomower | Lender | Loans | Reports | Forms | Help
Search by
@ Applicant 1D {Randem ID/Acoount Number)
) Applicant Name/State L1l States
' Lender
Lender 1D * Branch =
Submit Reset ID Cross Reference I
Action ['!:e‘x Application Package Zj
Pkg  Applicant Received Lender Rgt  Loan
Nbr 1D Applicant Name Date ID/Branch  Lender Name Nbr  Type
002 017202013 N oL
001 08/152008 ] FO
02 0
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DD FLP Oversight Review User Guide (Continued)

Exhibit 36
(Par. 442, 443)

C Oversight Review General Information (Continued)

3 Accessing Guaranteed Loan Reports (Continued)

Step Action

Package View Screen:

e lender name and type
e received date
e completion date

11 |The following information will be displayed on the GLS Farm Loan Application

SDA 6LS Farm Loan Application Package View
Laca

Szs. Format for Printing

i

P Update Application Package

Loan Applicant Information

Applicant
Phone:
Fax: None
Farming or Ranching Now: Yes Ei:?n:;;a";éng
Spouse/Other ID Phone:
Number Fax: None

Lender Information

Lender ID /

Branch Lender Type:

\ Phone:
Fax: None
Lender Contact Phone: |
Position COMMERCIAL LOAN OFFICER Fax: None

Cert/Pref Lender PREFERRED

Status/Agency Information - Application Package

GLS Home ‘ FSA Home | List Applications \ Add Application ‘ Add Request Borrower‘ Lender| Loans ‘ Reports ‘ Forms | Help|

CAIVRS Verified Date  01/29/2013

Received Date 01/29/2013 Geographic State ALABAMA

Completion Date 02/15/2013%« Geographic County DE KALB
Servicing State ALABAMA
Servicing Office RAINSVILLE

2-3-14
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Exhibit 36
(Par. 442, 443)
DD FLP Oversight Review User Guide (Continued)

C Oversight Review General Information (Continued)

3 Accessing Guaranteed Loan Reports (Continued)

Step Action
11 |e environmental review type and date completed

(Cntd)|e approval date

e incomplete letter dates

e closing date.

Environmentai keview Informarion - Application rackage

Environmental Review CATEX «~ Date Completed \02/27/2013
Consultation Required No Date Completed None
I |
Environmental Comments
=
Guarantee Requests
Application Package Number 2
Number of Guarantee Requests: 1 Total of All Guarantee Requests: $52,000.00
Sequence Completion
Number Date Loan Type Loan Amount Status
01 02/15/2013 Operating Loans $52,000.00 Obligated
Application Package Status and History
Current Application Package Status Application Package History &
APPROVED APPROVED 02/27/2013
COMPLETED  02/15/2013
PENDING 01/29/2013

RECEIVED 01/29/2013

Application Package Letter/Review Information

Incomplete Letter 1 Date Sent 01 /30/2013/
Incomplete Letter 2 Date Sent

Real Estate Appraisal Review Date

Chatte| Appraisal Review Date
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Exhibit 36
(Par. 442, 443)
DD FLP Oversight Review User Guide (Continued)

D Part A: Quarterly Review

Note: Use the “Review Area Comments” section to note issues on which to followup or other
comments relevant to the review.

1 “Direct Loan Making: Review Of Direct Loan Applications”
A “Complete/Approved Application File Reviews”

Review 5 applications received since last review; review all if less than 5. Information
sources include the following:

1940-G-1 Letter

DLS Loan Making Checklist

DLS Loan Request Detail Screen
FSA-851

FSA-2307

FSA-2308

OY FLPDM Direct Application Report
RD 1940-22 in FBP.

Question Source

1: Applicant Name Select 5 applications from DLS Reports, Loan Making
Reports, Direct Applications, and OY FLPDM Direct
Application Report.

2: Applicant representation is consistent |Compare the application against the Farm Program
within all FSA programs (Applicant Eligibility report.
has not applied for or received Agency
benefits under any other name, entity
or identification number)

3: Applicant was notified of receipt of Check the date on FSA-2307 from the borrower case
complete application file and DLS Loan Making Checklist.

4: Applicants were notified within 5 days |Check the date on FSA-2308 from the borrower case
of an eligibility determination file and on DLS Loan Making Checklist.

5: Appropriate environmental assessment |RD 1940-22 is online under the credit action used to
completed approve this loan in FBP. Also check FSA-851 and

the date of the RD-1940-G-1 Letter.

6: If application was held over 45 days Review the DLS Loan Request Detail Screen. This
without a loan decision, was a reason | will also print out on the Data Mart Application

entered in DLS? Report if comments have been inserted.

7: Credit decision (approval/rejected) was |DLS FLP Application Report. Information should be
made within 60 days of receipt of in the running record of either the FBP Credit Action
complete loan application and/or borrower case file.

2-3-14 1-FLP (Rev. 1) Amend. 94 Page 28



DD FLP Oversight Review User Guide (Continued)

Exhibit 36
(Par. 442, 443)

D Part A: Quarterly Review (Continued)

1

2-3-14

“Direct Loan Making: Review Of Direct Loan Applications” (Continued)

B

“Incomplete Application File Reviews”

Review 3 applications received since last review; review all if less than 3. Information
sources include the following:

e Dborrower case file
e DLS Loan Making Checklist
e FSA-2304
e FSA-2305
e OY FLPDM Direct Application Report.
Question Source
1: Applicant Name Select 3 applications from DLS reports, Loan
Making Reports, Direct Applications, and OY
FLPDM Direct Application Report.
2: Required notifications were sent to DLS Application Report will show the date that
applicants within required timeframes  |the decision was made. Borrower case files will
have copies of FSA-2304 and FSA-2305.
3: Items needed for a complete application |FSA-2304 and FSA-2305.
are clearly identified in notifications
DLS Loan Making Checklist may have
information if it was entered into DLS “Loan
Processing” section.
4. Applicants are notified of required due |FSA-2304 and FSA-2305.
dates for items needed for complete
application

1-FLP (Rev. 1) Amend. 94 Page 29




DD FLP Oversight Review User Guide (Continued)

Exhibit 36
(Par. 442, 443)

D Part A: Quarterly Review (Continued)

1 “Direct Loan Making: Review Of Direct Loan Applications” (Continued)

C “Withdrawn Application File Reviews”

Review 3 applications received since last review; review all if less than 3. Information

sources include the following:

e Dborrower case file
e FSA-2304
e FSA-2305
e FSA-2306
e QY FLPDM Direct Application Report.
Question Source
1: Applicant Name Select 3 applications from DLS reports, Loan
Making Reports, Direct Applications, and
QY FLPDM Direct Application Report.
2: SDA Application report.

is clearly documented

3: Reason for the withdrawal of application

FSA-2306 should be clearly documented.
The borrower case file running record should
also contain this documentation.

4. A complete application was received

Documented in DLS and on FSA-2001.

complete application

5: If a complete application was not
received, an effort was made to obtain a

FSA-2304 and FSA-2305.

6: ECOA and non-discrimination

correspondence to applicant

statements have been included in

FSA-2306 and the borrower case file.
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DD FLP Oversight Review User Guide (Continued)

Exhibit 36
(Par. 442, 443)

D Part A: Quarterly Review (Continued)

1
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“Direct Loan Making: Review Of Direct Loan Applications” (Continued)

D “Rejected Application File Reviews”

Review 3 applications rejected since last review; review all if less than 3. Information

sources include the following:

e Dborrower case file
e QY FLPDM Direct Application Report
e rejection letter.

Question

Source

1: Applicant Name

Select 3 applications from DLS reports, Loan
Making Reports, Direct Applications, and
OY FLPDM Direct Application Report.

2: SDA

Application report

3: Reasons for denial including applicable
citations of requirements from CFR are
clearly documented in the notification
letter to the applicant

DLS has a drop-down list to select the
reasons for denial. This is just a summary, to
determine the reason. Review the rejection
letter, if necessary.

4: Appropriate review/appeal rights were
included in the notification letter to the
applicant according to 1-APP

5. ECOA and non-discrimination
statements were included in the
notification letter to the applicant
according to 1-FLP

Review the rejection letter.
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DD FLP Oversight Review User Guide (Continued)

Exhibit 36
(Par. 442, 443)

D Part A: Quarterly Review (Continued)

2 “Guaranteed Loan Making: Review Of Guaranteed Loan Applications”

Review 5 applications received since last review; review all if less than 5. Information sources
include the following:

Farm Program Eligibility Report
FSA-851

FSA-2292

GLS 2209A report

GLS Farm Loan Application Package View Screen
GLSAPP02 — Guaranteed Loan Applications Detail Report

RD 1940-22.

Question

Source

. Applicant Name

GLSAPPO2.

Lender Name

GLSAPP02, GLS2209A, and GLS Farm
Loan Guarantee Request View Screen.

Lender Type: 1-SEL, 2-CLP, 3-PLP

GLS2209A and GLS Farm Loan
Guarantee Request View Screen for each
applicant.

. Applicant representation is consistent within all

FSA programs (Applicant has not applied for or
received Agency benefits under any other
name, entity or identification number)

Compare the application against the Farm
Program Eligibility report.

Lender was notified of incomplete and/or
complete application within timeframes
prescribed in 2-FLP (2-FLP, paragraph 95)

GLS Farm Loan Guarantee Request View
Screen for each applicant.

Eligibility of borrower and loan purposes have
been evaluated; denial/withdrawal are
thoroughly documented and appropriate
appeal/review rights were provided

(2-FLP, paragraph 108)

Borrower case file documentation and
correspondence and FSA-2292.

. Processing times are within timeframes

prescribed in 2-FLP for lender type
(2-FLP, paragraph 83)

GLS2209A.

. Appropriate environmental assessment

completed
(1940-G and 2-FLP, paragraph 208)

RD 1940-22, FSA-851, and GLS Farm
Loan Application Package View Screen.

2-3-14
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DD FLP Oversight Review User Guide (Continued)

Exhibit 36

(Par. 442, 443)

D Part A: Quarterly Review (Continued)

3 “Direct Loan Servicing”

A “Delinquent Account Servicing”

2-3-14

“Borrowers With Loans 90 Days Or More Past Due”

borrower case file

discussions with Service Center

DLS Special Servicing (SS) Borrower History Report
OY FLPDM Status of Farm Loan Programs 540 (Routine Servicing).

Review all accounts in this category. Information sources include the following:

this section will be reviewed.

Question Source
1. Borrower |Status of Farm Loan Programs 540, available from Data Mart, lists all
Name borrowers who are 90 days or more past due. All borrowers listed in

Farm Loans 540 Status of Farm Loan Programs
As of: 06/30/2013
SERVICING OFFICE LOCATION -
CASE NUMBER
BORROWER NAME 8T CO BORR-ID
DAILY
LOAN SERVICING FD LN UNPAID BALANCES INTEREST
INFORMATION CODES co NO INTEREST PRINCIPAL  ACCRUAL
BORROWERS WITH LOANS 90 DAYS OR MORE PAST DUE :
0160 A\ MALE  NON
202 PDD 1211 41 01 $4,669.13 $50,540.62 83080
TOTAL $4,669.13 $50,540.62 83080
0132 A MALE  NON
307 PDD 0828 49 03 $6,057.85 $141,803 66 18.9516
307 POD 0828 “ o $2,860.18 $78,228.86 9.1088
TOTAL $8,918.03 $220,12252 28,0604

1-FLP (Rev. 1) Amend. 94

COUNTYFSA( )

DATE OF
INTEREST LAST CASH

RATE  PAYMENT

PLS
6.0000 121152011

PLS
48750  06/03/2013
42500 082012012

PAYMENT STATUS
A -AHEAD

B - BEHIND

$362600 B

M 0807
8704210 B
$857370 B

SCHEDULED
ANNUAL FY

INSTALLMENT LN

$3713.00 41
$3,713.00

$8,274.00 45
$8,574.00 2
$16,848.00
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DD FLP Oversight Review User Guide (Continued)

D Part A: Quarterly Review (Continued)

3
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“Direct Loan Servicing” (Continued)

A “Delinquent Account Servicing” (Continued)

I “Borrowers With Loans 90 Days Or More Past Due” (Continued)

Question

Source

2:

PLS history
report
indicates a
PLS notice
was sent
within

15 calendar
days of
borrower’s
account
becoming
90 days
past due
(the receipt
of the
Report
Code 540)

Navigate to the DLS SS Borrower History Report as follows:

Step 1: CLICK “SS” icon from the DLS dashboard for the borrower.

Step 2: CLICK “Special Servicing” tab.

Natona Offic | State Offce | Sevice Center | Borrower |
Borrower FL OM CR GR LR YA FV

o 0900 0 VY
}keminders ]
Reminders

T S § 4T

! ORAY -

Y

Spacil Servitin

Customer Management

Open Categories

Loan Making

LS - TRA

LS - Dashboard
Special Servicing

|| 90DaysPastDue |

S0 DAYS PAST DUE
09/03/2012 Version: 1.4

Category Name:
Initislized Date:
Default Date: 09/03/2012

Days in Default: 234

Function | Activities

Open Activity Paths =

DLS SS Borrower History Report will indicate an initialization date
that is the date that borrower becomes 90 days past due:

e locate the activity description indicating that the borrower was sent
Primary Loan Servicing notifications

e ensure that this date is within 15 days of initialization.
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Exhibit 36

(Par. 442, 443)

D Part A: Quarterly Review (Continued)

3

2-3-14

“Direct Loan Servicing” (Continued)

A “Delinquent Account Servicing” (Continued)

“Borrowers With Loans 90 Days Or More Past Due” (Continued)

Question Source
Offset notice | Following the steps in Question 2 to determine if borrower was also
was sent at  |sent Offset Notifications.
the same
time as the | After obtaining the information required for Questions 1 through 3,
PLS notice |review these items with the Service Center.
(required
when
account is in || select one of the following Category Assignment(s)
monetary e
default) Select Category Name Initiation Date g:;::l:
'\EI' S0 DAYS PAST DUE 08/03/2012 0S8/03/2012

Closed Categories

Select

Category Name

Initiation Date

Completion
Date

C) CURRENT/FINANCIALLY DISTRESSED BORROWER

06/15/20059

06/16/2008

Select the desired version of the Borrower History

& Borrower History by Branch
(O Borrower History by Branch with Comments
O Borrower History, Chronological by Activity

Under “Open Categories”, CLICK “Select” for the borrower and

CLICK “Submit” to open the Borrower History Report.
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D Part A: Quarterly Review (Continued)

3

2-3-14

“Direct Loan Servicing” (Continued)

A “Delinquent Account Servicing” (Continued)

I “Borrowers With Loans 90 Days Or More Past Due” (Continued)

Question Source

4: Enter Discuss with Service Center the anticipated resolution for the account.
anticipated
resolution Borrower to pay current: enter source of funds in comments.

1
2.
3.
4
5

The Borrower History Report can be used to answer Questions 2 and 3
for this review.

Restructuring of account will be necessary.
Borrower will voluntarily liquidate.
Account will be accelerated.

Other: enter explanation in comments.

COMPLETE TIME CLOCKS

[T cLoKx DEscRIpTION St S OATI ___Davs |

T COMPLETION | ILAPSID |

OPEAN TIME CLOCKS

;lnm CLOCK DESCRIPTION DUT DATE

PRIMAKY BOKKOWER BRANOH, nun-

[acrivary |
Iwon

Al * MAIL ACCEPTED

COMPLETION/ ELAPSED  CWAKY/ |
"

OISR eTION s ACTIVITY

WALT FOR MALL, 1031 COFFSET LETTER

012002
* CERTIFIFD MAIL UNCLAIMED OR UNDELIVERADLE

|ACTIVETY COMPLETION/ TLAPSID OsARY/
na

OESCRIPTION DUE DATE DAYS  ACTIVITY
VALY FORK MALL FEA 23308 2511

s * MAIL ACCEPTED 012012 i 2.4
® CERTIFEID MATL UNCLAIMID O UNDELIVIRABLL

Note: See DLS User Guide for additional instructions on navigating

to a borrower and accessing Special Servicing Borrower
History Report.
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(Par. 442, 443)

D Part A: Quarterly Review (Continued)

3

2-3-14

“Direct Loan Servicing” (Continued)

A “Delinquent Account Servicing” (Continued)

“Borrowers With Loans 90 Days Or More Past Due” (Continued)

Question

Source

5: Enter target date
for resolution of
delinquency

be resolved.

Together, create a target date for when delinquent account may
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Exhibit 36

(Par. 442, 443)

D Part A: Quarterly Review (Continued)

3 “Direct Loan Servicing” (Continued)

A “Delinquent Account Servicing” (Continued)

2-3-14

Il “Borrowers With Loans Less Than 90 Days Past Due”

Review all accounts in this category. Information sources include the following:

e Dborrower case file

e DLS Special Servicing (SS) Borrower History Report
e discussions with Service Center

e OY FLPDM Status of Farm Loan Programs 540 (Routine Servicing).

more past due. All borrowers listed in this section will be reviewed.

Question Source
1. Borrower Status of Farm Loan Programs 540, available from Data Mart,
Name contains a section listing all borrowers who are 90 calendar days or

Status of Farm Loan Programs
As of: 06/30/2013

Farm Loans 540

SERVICING OFFICE LOCATION -
CASE NUMBER
BORROWER NAME S$TCO BORRID
DAILY
LOAN SERVICING FD LN UNPAID BALANCES INTEREST
INFORMATION CODES e NO INTEREST PRINCIPAL  ACCRUAL

BORROWERS WITH LOANS LESS THAN 90 DAYS PAST DUE :

k ND WM A MALE  NON
79PDD M 4 0 $3.53 $460.36 0.0642
TOTAL $3.53 $480.36 00642

M. iR " 3 WH MALE NON
61PDD FYLN, 40 456626 $15,624.40 0.9631
TOTAL $568.26 §15624 40 09631

1-FLP (Rev. 1) Amend. 94

COUNTY FSA )

DATE OF
INTEREST LAST CASH

RATE  PAYMENT

48750 05062013

22800 1inm20m1

PAYMENT STATUS
A-RHEAD

B - BEHIND

He3se B

M 0410
$822200 B

SCHEDULED
ANNUAL FY

INSTALLMENT LN

§000 13

S000

Page 38



DD FLP Oversight Review User Guide (Continued)

Exhibit 36
(Par. 442, 443)

D Part A: Quarterly Review (Continued)

3 “Direct Loan Servicing” (Continued)

A “Delinquent Account Servicing” (Continued)

Il “Borrowers With Loans Less Than 90 Days Past Due” (Continued)

Question

Source

2: Delinquency
can be
resolved
before
account
enters

90 days past
due

Navigate to the DLS SS Borrower History Report as follows:

Step 1: CLICK “SS” icon from the DLS dashboard for the borrower.

Step 2: CLICK “Special Servicing” tab.

NationalOffice | State Offie ] Senice Center | Borrower |

Borrower FLOW QR G IRYA FV TA S 8 }_M R
o Q WY -0\ 0 0 KN ¢

Open Categories

|| 90DaysPastDue |

Customer Management
Loan Making

LS -T&A

LS - Dashboard
Special Servicing

S0 DAYS PAST DUE
09/03/2012 Version: 1.4 Status: Open

Category Name:
Initislized Date:
Default Date:

Days in Default: 234

09/03/2012

Function Activities

Open Activity Paths 3

Determine if Primary Loan Servicing notifications have been sent.

Notes: Servicing notification is not required for borrowers less than

90 days past due

Borrowers may not have been initiated into DLS SS.

2-3-14
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Exhibit 36
(Par. 442, 443)
DD FLP Oversight Review User Guide (Continued)

D Part A: Quarterly Review (Continued)
3 “Direct Loan Servicing” (Continued)
A “Delinquent Account Servicing” (Continued)

Il “Borrowers With Loans Less Than 90 Days Past Due” (Continued)

Question Source
2: Delinquency |IF notifications have... |THEN...
can be been sent use the Borrower History Chart to
resolved determine the following:
before
account e borrower’s response
enters
90 days past e whether resolution appears likely before
due the borrower becomes 90 calendar days
(Continued) past due.
not been sent review case file and discuss with the
Service Center to complete this question.
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DD FLP Oversight Review User Guide (Continued)

D Part A: Quarterly Review (Continued)

3

2-3-14

“Direct Loan Servicing” (Continued)

A “Delinquent Account Servicing” (Continued)

Il “Borrowers With Loans Less Than 90 Days Past Due” (Continued)

Question Source
3: Anticipated Discuss with Service Center the anticipated resolution for the account.
resolution

e Borrower to pay account current.
e Restructuring of account will be necessary.

e Other, restructuring not possible.

COMSLETE TIME CLOCKS

COMPLEITION fLAPSED
TIME CLOCK DESCRIPTION DUE OATE DATE DAYS ]

OPEN T QLOCKS
TIME COLOCK DESCRIPTION DUL DATE I

PRIMARY BORROWIER DRANCH 'AIIAQMJQ()__
Th & telaed

I © % 4 68T FIAANC ALY DISTRESSEO BORASWER o0 22-08

COMMETION/ LAPSSD CMARY/

ACTIVIYY

Y OSSCRIFTION OUE DATE OAYS  ACTIVEITY

WAILT FOR 0'S RESPONSE TO FSA 2312 & 2510

e DPROVIDES COMP APPLN FOR STRVICES W/ IN 80 DAYS
A * B DOLS NOT PROV COMPL APPLN W/IN 80 DAYS 04-16-201) S
* B RICOMES 90 DAYS PAST DO

* BORROWER KIQUESTS DIST SETTLEMINT
* DORROWER PAYS CURRENT OR TN FULL

Use the Borrower History Report to determine if the borrower has
requested loan servicing and whether any servicing actions have taken
place. This will help determine if the account is anticipated to be
resolved before it becomes 90 calendar days past due.

Note: See DLS User Guide for additional instructions on navigating
to a borrower and accessing the Special Servicing Borrower
History Report.

4: Target Date
for resolution
of delinquency

Together with Service Center, create a target date for when delinquent
account may be resolved.
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(Par. 442, 443)

DD FLP Oversight Review User Guide (Continued)

D Part A: Quarterly Review (Continued)
3 “Direct Loan Servicing” (Continued)
A “Delinquent Account Servicing” (Continued)
11 “Borrowers With Loans That May Require Attention”

Review all accounts in this category. Information sources include the following:

e 4-FLP

e 5-FLP

e borrower case file

e CCC-257

e discussions with Service Center
e FSA-603

e OY FLPDM Status of Farm Loan Programs 540 (Routine Servicing).

Question Source
1: Borrower Name Status of Farm Loan Programs 540, available from Data
Mart, lists borrowers with loans that may require attention
as well as the flags present on the accounts.

Farm Loans 540 Status of Farm Loan Programs
As of: 06/3012013
SERVICING OFFICE LOCATION - COUNTYFSA. )
CASE NUMBER
BORROWER NAME $TCO BORRID
DALY DATE OF PAYMENT STATUS SCHEDULED
LOAN SERVICING FD LN UNPAID BALANCES INTEREST  INTEREST LAST CASH A-AHEAD ANNUAL  FY
INFORMATION CODES cD NO INTEREST PRINCIPAL  ACCRUAL  RATE  PAYMENT B-BEHIND INSTALLMENT LN
[BORROWERS WITH LOANS THAT MAY REQUIRE ATTENTION (OTHER):
¥ s a AA MALE  NON
1054 PODD M 4 01 $168 $173n 00202 42500 8 3 $17499 B $0.00 10
TOTAL $168 $173.31 0.0202
3] WH  MALE  NON SAA M 0311 M 0292
0101 4“4 2% $250.64 $14036.12 231 60000 03182013 $2,196.00 il
ISA “ 2% $§73200 $0.00
2: Account Flag See to 5-FLP, Exhibit 11 for more information about

account flags.
3: Payments are being | Questions 3 and 4 can be answered after the following:
made and are current

according to an e discussing each account with the Service Center
approved plan or e reviewing the borrower’s case file and correspondence
agreement e reviewing FSA-603 and CCC-257, if necessary.

4: Accounts are serviced
according to Note: Use 4-FLP and 5-FLP as sources for any regulations
applicable regulations or handbook questions.

and/or handbook
instructions
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Exhibit 36

(Par. 442, 443)

D Part A: Quarterly Review (Continued)

3 “Direct Loan Servicing” (Continued)

B “Payments and Collections”

Review a sample of 5 accounts in this category; review all if less than 5. Information sources

include the following:

3-FI

4-FLP

borrower case file
CCC-257

FSA-603

discussions with Service Center

OY FLPDM Status of Farm Loan Programs 540 (Routine Servicing).

Question

Source

1: Borrower/Account
Name

Select 5 accounts from FSA-603 to review. If collection was not
made at this Service Center, add the county name where collection

was made.

FSA-603 provides information about payments received from
borrower accounts. This will be used for comparison to other

forms/reports to ensure payments are applied correctly.

2-3-14

B. C. C. E.
MAME OR 1D, MO, REMITTANCE INFO. AMOUNT SCHEDULE NO.
OF REMITTER COLLECTED FROM FORM
ENTER 7 GCG-257
CHECK NO. ChsH
03/29/2013 |Doe, John 1754 . 12,671.19 123
03/29/2013 |Smith, Borrower 1562 . 8,764.12 123
03/29/2013 [Happy Hills Farms 2462 . 58.41 123
03/29/2013 |Jones, Michael 1313 . 874.55 123
03/29/2013 Hillshire Farmland 3323 . 27,894.73 123
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(Par. 442, 443)

DD FLP Oversight Review User Guide (Continued)

D Part A: Quarterly Review (Continued)

3 “Direct Loan Servicing” (Continued)

B “Payments and Collections” (Continued)

Question

Source

2: Payment(s) and
collections are
applied within
prescribed time
frames

3: Payment(s) are
credited to the
account(s) of the
correct borrower

Compare FSA-603:

e and CCC-257 to ensure that account names, check numbers,
and payment amounts match and that deposit is being made
timely

e “Date Received” column and Status of Farm Loan
Programs 540, “Date of Last Cash Payment” column to
ensure that the dates match.

Note: 3-FI, paragraph 37 provides additional information about
timeframes for making deposits.

TCC 57 .5, DEPARTMENT OF AGRICULTURE 1A Schedule Date
(03-02-10) Farm Service Agency 3/29/2013

SCHEDULE OF DEPOSIT

For depositto the account of CCC-Symbol 4992

1B. Page 1 of &

2. To: CCC-257 LOCKBOX BANK 3. Rgpgﬂ_D_epggit_t_orw_.
P.0. BOX 790134 g
ST. LOUIS MISSOURI 63179-0134
A B T. D.
RECEIPT ID CHECK/ITEM MO. REMITTER IDENTIFICATION AMOUNT
(A Manus! o
cce v
/A 1754 Doe, John 12,671.19
/A 1562 Smith, Borrower 8,764.12
L E2hS Happy Hills Farms EEECEE
/A 1313 Jones, Michael 874.55
n/a 39939 Hillshire Farmland 27,894.73

4: Payment(s) are
applied to the
borrower’s loan(s)
according to 4-FLP

Review 4-FLP, Part 5 and discuss payments received to
determine if reviewed account payments were Regular or Extra
Payments. Ensure that payments were applied correctly to
loan(s).

5: There is a proper
separation of duties
among employees
handling
transactions

Review 3-FI, paragraph 3 with Service Center employees to
ensure that the separation of duties outlined exists in the Service
Center.

2-3-14
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DD FLP Oversight Review User Guide (Continued)

D Part A: Quarterly Review (Continued)

3

2-3-14

“Direct Loan Servicing” (Continued)

C “Chattel Security Accounting”

Review a sample of 5 accounts in this category; review all if less than 5. Review additional
files if deficiencies are found. Information sources include the following:

4-FLP
borrower case file

FBP
FSA-2028
FSA-2040.

discussions with Service Center

Question

Source

1: Borrower Name

View 5 borrower accounts that had dispositions in the previous
quarter. Review FSA-2040 to ensure that planned sales match
actual sales and that variances are documented in borrower case
file.

FSA2000 - U5 DEPARTHENT OF AGRICULTURE N Fostian1
{12-31-07) Farm Service Agency

AGREEMENT FOR THE USE OF PROCEEDS/RELEASE

OF CHATTEL SECURITY
T TENE 2. CROFTERR
Farmer Smith 2012
3. DATEQF SECURITY INSTRUMENT:  1/1/2012 4, BEGINNING DATEOF THISAGREEMENT:  1/1/2012

5, Areany listed items inthe property descripiions below from a previous Form FSA-2040 {orF54-1982-01)7 Ifso, indicate below with an astensk(*), and

enter the beginning date ofthat Agreement

. PROPERTY DESCRIPTION:  Brass Hay
PLANNED ACTUAL

(=

A B c : F G H
Cusntity How Manth Quantity How Dtz

PR -
133 Toms | Sell Vasions §41, 500 §i5, 248 35 Toma | Sell Juna §10.521 | PER X 0e-22-11 M2

2: Dispositions and
proceeds are
recorded on
FSA-2040

Review FSA-2040 and FBP to determine if dispositions:

e occurred as planned
e were accounted for
e were approved.

Discuss any discrepancies with loan officers.
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DD FLP Oversight Review User Guide (Continued)

D Part A: Quarterly Review (Continued)

3

2-3-14

“Direct Loan Servicing” (Continued)

C “Chattel Security Accounting” (Continued)

Question

Source

Funds are released
in accordance
with the FBP and

Review 4-FLP, paragraph 163 and ensure that proceeds are applied
correctly and released when appropriate. Discuss any discrepancies
with loan officers.

FSA regulations

as applicable

Work copy of Review the most recent work copy of FSA-2028 to verify that it
Security matches any changes to FSA-2040.

Agreement has
been notated for
any changes in
collateral
(FSA-2028)

Items of security that have been sold, junked, traded, etc.:

e should be lined off of the work copy of FSA-2028
e notated as to the manner and date of disposition.

Discuss any discrepancies with loan officers.

FSA-2028 (020210 Fage 2 of
ted
o ity - P
DISC KEWANEE FT FARR
D = AR | E—

R&J 8-ROW GOOD
4 NOBLE FT FAIR
1|ROTARY HOE D E0400 FAR
6 1 |PITCHOUT RIG R&]J $-ROW FAR
1|PLOW D ROLLOVER FAR
8 2|FERT.IN].PUMPS  |BALDOR 13HP GOOD
8 2 |FERT. GAL FAIR
10 3 | IRRIGATION CHEV 92 GOOD
1|TRALLER UTLLITY 6FT. FAR
1| TANK MOBILE 500 GAL FARR
WOODS 6-ROW FARR
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DD FLP Oversight Review User Guide (Continued)

D Part A: Quarterly Review (Continued)

3

2-3-14

“Direct Loan Servicing” (Continued)

C “Chattel Security Accounting” (Continued)

Question

Source

FLM follows up
on all apparent
unauthorized
dispositions; using
5-FLP, Exhibit 31
to notify
borrowers in all
cases and obtains
adequate
documentation to
enable post
approval where
applicable

For any unapproved disposition:

e review borrower case file documentation
o discuss with loan officer to determine anticipated resolution.
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DD FLP Oversight Review User Guide (Continued)

D Part A: Quarterly Review (Continued)

4

2-3-14

“Program Delivery FLP Goals: From FLP goals established by the National Office for

your state”

For all goals, enter State goal, Service Center goal, and FLP staff progress. Information sources
include the following:

e direct loan making goals are available from Data Mart and Goals OnDemand reports
e guaranteed loan making goals are available from the GLS Reports.

Goal

Source

1. Firstyear
delinquency
rate on new
loans (%).
(Direct Loan
Making)

From the Data Mart Goals On Demand Reports, select “OY FLPDM
Reduce 1st Year Delinquency Rates on New Loans Goal 1”. To view all
Service Centers within the district, make the following selections on the

Reduce 1st Year Delinquency Rate on New Loans by 25% Over 5 Years
Screen, and CLICK “Run Report”:

e “Report Date”

e “District”

e “All Service Centers”

e “Reduce 1st Yr Dinq by Service Office”.

Reduce 1st Year Delinquency Rate on New Loans by 25% Over 5 Years
Date Selection: (MUST click "Submit' when changing date)
@ DatebyMonth  or O DatebyFY

State Selection:

Report Date:

2013107 v

Drill Down Selection:
District: Servicing Office:

All Districts ~ All Service Offices

DISTRICT 01

DISTRICT 02
DISTRICT 03
DISTRICT 04

Hold the CNTL or SHIFT key down for Multiple Selections

Report Selection:

Reduce 1stYr Ding by State & ~ EQCUJ?DT;;

Reduce 1stYr DIng hy District o
Reduce 1st Yr Ding by Service Office © PDF Format

Reduce 1stYr Ding Service Office within State v O Print

Notes: All performance data can be input for each Service Center at 1 time.

When closing out reports always CLICK “No” for “Save Changes?”.

Interactive Reporting Web Client

Save changes ?

(tions] [l ——
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4

2-3-14

“Program Delivery FLP Goals: From FLP goals established by the National Office for
your state” (Continued)

time (Days).
(Direct Loan
Making)

Goal Source
2: Directloan |From the Data Mart Goals On Demand Reports, select “OY FLPDM
processing |Reduce Average Processing Times for Direct Loans Goal 2”. To view all

Service Centers within the district, make the following selections on the
Reduce Average Processing Times for Direct Loans - Goal 2 Screen, and

CLICK “Run Report”:

“All Races” and “All Genders”

“District” and “All Service Offices”

“All County Offices” and “All Borrowers”

“Reduce Average Processing Times by Service Office”.

Reduce Average Processing Times for Direct Loans - Goal 2
Date Selection: (MUST click "Submit' when changing date) State Selection:

Fiscal Year:

[2013 v

O DatebyRange or & DatehyFY v

Drill Down Selection: @ Al O Hispanic O Non-Hispanic
Race: Gender:
A~ All Genders ~
AMER INDNALSK NATV FEMALE
ASIAN MALE
BLACK v ORGIFEMALE v

District: Servicing Office: County: Borrower:

Hold the CNTL ar SHIFT key down for Multinle Selections

Report Selection:

~ All Borrowers
v \

@ Brio Format

Reduce Average Processing Times by District Race/Gender A O Excel Format
Reduce Average Processing Times by Service Office Run Report
Reduce Average Processing Times by Senvice Office RaceiGender © PDF Format

Reduce Average Processing Times hy County Office v O Print

1-FLP (Rev. 1) Amend. 94
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D Part A: Quarterly Review (Continued)

4

2-3-14

“Program Delivery FLP Goals: From FLP goals established by the National Office for
your state” (Continued)

Goal

Source

3: Guaranteed
loan
processing
time (Days)

On the GLS Guaranteed Loan System Screen, CLICK “Reports”. From the
GLS Application Reports Screen, CLICK “GLS2208 — Guaranteed Loan
Average Processing Times”.

USDA United States Department of Agriculture

- GLS Guaranteed Loan System

GLS FSA
Home Home Borrower Lender Loans Reports Help

Application Package List

Application Package Add

Loan Guarantee Request Add

Loan Guarantee Request Update

Loan List

Administrative Fee/Treasury Rate List

ESA NAICS List L
FSA Integrator/Contractor List 7
Reference Table List

GLS 1099C Control Dates

-
Reports ==
Forms
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D Part A: Quarterly Review (Continued)

4

2-3-14

“Program Delivery FLP Goals: From FLP goals established by the National Office for
your state” (Continued)

Goal Source
3: Guaranteed | The goal is calculated using “Environmental Review Type”, “CATEX”. On
loan the Search Criteria Screen, select timeframe for the quarter being reviewed.
processing
time (Days) |e From the “Sort Options” drop-down lists, selecting:
(Continued)

e “Servicing State”, allows drilldown to Service Centers
e “Geographic State”, allows drilldown to counties.

e “Report Options” drop-down lists allow drilldown to detail.
From the online report, all States are visible. Select State to see the

breakdown between Service Centers, and then select additional options to
drilldown to detail.

Search Criteria
Specify Search Criteria to restrict the contents of the report fo enfries which mafch your specifications,

Process Date 2pplications Received . t—

October « 01 » 2012 May v 09 « 2013
From (eg.2000) [ (.2.2000)

Environmental Review Type [Eis il v =

Loan Type [¥] EE [ EL [¥] EM ¥ FO F] CL
| OL-LOC [/ OL ¥ SW [¥] LCPP [v] LCSG

Sort Options

Specify Sort Option to conirol the order in which selected entries are displayed on output report.

Mayor Servicing State v BAscending Order
Minor Sort Race v Ahscending Order
Report Options

belect a "Repa Format" from the drop down list; Select a delivery route;(fill in an email address if email distribution is selected.);

Select "Submit Query" fo generate the report; or Select "Reset” to clear the form;

Report Format: Allow Drilldown to Detail » View report online v
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D Part A: Quarterly Review (Continued)

4

2-3-14

“Program Delivery FLP Goals: From FLP goals established by the National Office for
your state” (Continued)

Goal Source
3: Guaranteed |Verify that the report was created for CATEX applications. By selecting the
loan State name, the report breaks data down into Service Centers that will
processing |provide the average processing times. The report must drilldown to detail to
time (Days) |access this information.
(Continued)
United States Department of Agriculture Page 1
GLS2208A FARM SERVICE AGENCY 05/13/13
GUARANTEED LOAN AVERAGE PROCESSING TIMES 07.39.36

Application Received FROM 10/01/2012 Ti 05/13/2013
Environmental Review: CAT
Loan Type: EE EL EM FO OL-LOC OL SwW CL LCPP LCSG

—_— 317 AMER IND/ALASK NAT
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DD FLP Oversight Review User Guide (Continued)

D Part A: Quarterly Review (Continued)

4  “Program Delivery FLP Goals: From FLP goals established by the National Office for
your state” (Continued)

Goal Source

4: Lendingto |From the Data Mart Goals On Demand Reports, select “OY FLPDM
beginning |Lending To Beginning Farmers and Ranchers Goal 4”. To view all
farmers and |Service Centers within the district, make the following selections on the
ranchers (%) | Lending to Beginning Farmers and Ranchers - Goal 4 Screen, and CLICK
(Direct Loan|“Run Report”:

Making)
applicable State

“All Races”

“All Genders”

“District”

“All Service Offices”

“All County Offices”

“All Borrowers”

“Lending to BF and Ranchers by Service Office”.

Lending To Beginning Farmers and Ranchers - Goal 4

Date Selection: (MUST click"Submit' when changing date) State Selection:
O DatebyRange or & Date hyFY x|
Fiscal Year:
Drill Down Selection: @ Al O Hispanic O Non-Hispanic
Race: Gender:
All Races -~ All Genders -~
AMER INDN/ALSK NATY FEMALE
ASIAN MALE
BLACK v ORGIFEMALE v
District: Servicing Office: County: Borrower:

Hold the CNTL or SHIFT key down for Multiple Selections
Report Selection:
P . : — (@ Brio Format
Lending to BF and Ranchers by District ~

Lending to BF and Ranchers by District Race/Gender O Excel Format Run Report
© PDF Format

Lending to BF and Ranchers by Service Office -
Lending to BF and Ranchers by Service Office Race/Gender v| O Print
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D Part A: Quarterly Review (Continued)

4  “Program Delivery FLP Goals: From FLP goals established by the National Office for
your state” (Continued)
Goal Source
5: Lending to |From the Data Mart Goals On Demand Reports, select “OY FLPDM
SDA Lending To Socially Disadvantaged Farmers and Ranchers Goal 5”. To
farmers and |view all Service Centers within the district, make the following selections on
ranchers (%) | the Lending to Socially Disadvantaged Farmers and Ranchers - Goal 5
(Direct Loan | Screen, and CLICK “Run Report”:
Making)
e applicable State
e “All Races”
e “All Genders”
e “District”
o  “All Service Offices”
e “All County Offices”
e “All Borrowers”
e “Lending to SDA Farmers and Ranchers by Service Office within State”.
Lending To Socially Disadvantaged Farmers and Ranchers - Goal 5
Date Selection: (MUST click "Submit” when changing date) State Selection:
© DatebyRange or @ DatebyFY [ALAEW\"'A A
Fizscal Year:
[2013 v] Submit
Drill Down Selection: @ All ' Hispanic  Mon-Hispanic
Race: Gender:
All Races - All Genders -
AMER INDMN/ALSK MATY FEMALE
ASIAN MALE
BLACK - ORGIFEMALE -
District: Senvicing Office: County: Borrower:
All Service Offices All County Offices All Borrowers
01-305 TUSCALOOSA 01 AUTAUGA 00zz2
01-308 ELMORE 02 BALDWIN 0023
01-309 COFFEE 05 BLOUMNT 0037
01-311 LAWREMNCE 06 BULLOCK 0037
- 01-313 DEKALB - 07 BUTLER - 0090 -
Hold the CNTL or SHIFT key down for Multiple Selections
R ion: .
eport Selection = = Brio Format ‘/
~ Excel Format
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D Part A: Quarterly Review (Continued)

4

2-3-14

“Program Delivery FLP Goals: From FLP goals established by the National Office for
your state” (Continued)

Goal

Source

6: Direct loan
delinquency
rate (%)
(Direct Loan
Servicing)

Provided by the State Office.

7: Guaranteed
loan
delinquency
rate (%)

Select from the GLS Caseload Reports, “GLS2085 — Guaranteed
Caseload/Delinquency Summary”. Select “Allow Drilldown to Detail” to
break data down by county.

The only option available is “Geographical State”; therefore, the data is
represented by counties. Add all the information for each county within the
Service Center to obtain the Service Center delinquency.

SDA GLS FSA 6L.52085 - Guaranteed Caseload/Delinquency
Summary

Home Home Add Application Borrower Lender Loans
Search Criteria
Specify Search Criteria to restrict the contents of the report to entries which match y
Geographic State CONNECTICUT -
Loan Type 211 Types -

Beginning Farmer/SDA @ No Selection ) Socially Disadvantaged Only
() Beginning Farmer Only © Both

Assistace Type Codes [
hold Cril for multiple select| 031 FO FE SDA E
032 FO DEMONSTRATION LNS

Report Options
elect a "Report Format" from the drop down list; Select a delivery route;(fill in an email address if email distribution is sel
or Select "Reset" to clear the form:

4 m

Report Format: Formatted for printing v View report online -
Formatted for printing
Bllow Drilldown to Detail
Query ] [ Reset Form

Excel Spreadsheet
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D Part A: Quarterly Review (Continued)

4  “Program Delivery FLP Goals: From FLP goals established by the National Office for
your state” (Continued)

Goal Source
8: Primary loan |Provided by the National Office to each State.
servicing
processing

times (days).
(Direct Loan
Servicing)
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Exhibit 36
(Par. 442, 443)

E PartB: Semiannual Reviews

Semi-annual review items shall be completed for the 2nd and 4th quarters of each FY.

Note: Use the “Review Area Comments” section to note issues on which to followup or other
comments relevant to the review.

1 Direct Loan Making: Loan Security Instruments

2-3-14

Review 5 new chattel or crop loans; review all if less than 5. Information sources include the

following:

e FBP Credit Action Report
e OL FLPDM Borrower Financing Statement Combined Report.

Question

Source

1: Borrower Name

FBP Credit Action Report.

2: Proper UCC Filed

Check the borrower case file to verify the proper UCC filing.

The offsite option is to create the report from Data Mart Direct Loan
Servicing/Routine Servicing, OL FLPDM Borrower Financing

Statement Combined Report.

Status; Active

Stater

Distict: 01401

Senvice Office: Al Seniing Ofices
County: Al Courties

No Date Selected

fLp
Mai

Code  Servicing Office ~ Borrower Name

UNITED STATES DEPARTMENT OF AGRICULTURE
FARM SERVICE AGENCY
DIRECT LOAN SERVICING
Borrower Financing Statement Detail Report

Sticy

Security Filing Filing Where

(ase Nor Instrument — Number Date Filed
Original QSO0 FS 01220009 01000

Orignal AN2019303FS 4092012 04000

1-FLP (Rev. 1) Amend. 94

Sec
Insir

Tipe
CFS

(FS

Alert
Date

(7222013

10092016

Page 1
083013
1755 RM

Expiration ~ Associated

Dag  Lows
2 4

(wna0n

40140
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E Part B: Semiannual Reviews (Continued)

1 Direct Loan Making: Loan Security Instruments (Continued)

2-3-14

Question

Source

. Security agreement and

promissory note in safe

Verify, while in the Service Center, that the promissory note is
filed in the Service Center fire proof safe.

. Agreement for Disposition

of Jointly Owned Property |the borrower case file.

Obtained

: CCC-10 has been executed

and is in the borrower case |agreement.

file (3-FLP)

If applicable, while in Service Center, review agreement from

Offsite option is the Service Center scans and e-mails the

1-FLP (Rev. 1) Amend. 94
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E Part B: Semiannual Reviews (Continued)
2 Direct Loan Servicing
A Shared Appreciation Agreements
Review all accounts listed. Information sources include the following:
e 5-FLP
e borrower case file
e FLM discussion

e operational file
e Report Code 565-A, “Borrowers with Expiring Equity Recapture Agreements”.

Question Source

1: Borrower Name |View current and past Reports 565-A sent to Service Centers monthly
by FLOO.

Review all borrowers with upcoming expirations or Shared
Appreciation Agreements that have expired since the last review.
Agreement may have matured for a reason other than time.

This form is available electronically.
FSA-2544 U.5. DEFARTMENT OF AGRICULTURE Fosfion®
(04-03-12) Farm Service Agency

REQUEST FOR INFORMATION ON CAPITAL IMPROVEMENTS

Date
Mr. John Farmer
Mrs. Jane Farmer Certified
12123 County Road Four 48151623424815462342

Washington, DC 20250

Ourrecords showthat vou have a Shared Appreciation Agreement with the Farm Service Agency (FSA) that has or will
soon be coming due.

F3Aregulations (7 CFR Part 766) allowthe value of certain improvements to be deducted from the current market value of
vour property to determine any shared appreciation due. Theimprovement has to have been added to the propertv since
voureceived vour writedown from FSA and capitalized on vour income taxes. The capital improvements must also meet at
least one of the following criteria

A Ttis vour primarv residence. If a newresidenceis affixed to the real estate securitv for a home which existed on the
security property whenthe SAA was originally executed. orthe living area square footage of the original dwelling
expanded, only the value added to the real property by the new or expanded portion of the original dwelling (if it
added value) will be deducted from the current market value. Living area square footage will not include square
footage of patios, porches, garages, and similar additions.

B. Theitemis an improvement to the real estate with a useful life of over 1 vear and is affixed to the propertv. The
item must have been capitalized and not taken as an anmial operating expense on Federal income tax records. You
must provide copies of appropriate tax documentation to verifv the capital improvements claimed.

A copy of FSA-2544 sent to the borrower should be located in the
borrower case file.
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E Part B: Semiannual Reviews (Continued)

2 Direct Loan Servicing (Continued)

A Shared Appreciation Agreements (Continued)

2-3-14

Question

Source

Expiration dates
of agreements
are monitored

Discuss with FLM how expiration dates are monitored and review
Service Center operational file if necessary.

Proper Borrowers who have Shared Appreciation Agreements expiring
notifications are |within 6 months are sent FSA-2544 notifying the borrower of the
sent to upcoming expiration and requesting information about improvements
borrowers made to the property.
This form is available electronically.
FSA-2545 U.5. DEPARTMENT OF AGRICULTURE Fosition &
(04-25-12) Farm Service Agency
BORROWER NOTIFICATION OF SHARED APPRECIATION DUE
DS.-']2.-"20135[
Farmer Brown CERTIFIED
123 Any Street 10010011100011001010
Farmville, CO 23810
This notice is to inform vou that the Shared Appreciation Agreement (SAA) vou executed on 05/08/2008 has or will
soon become due for the following reason:
+ The Shared Appreciation Agreement will mature on 05/02/2013.
The Agency has completed a current appraisal on thereal estate that secured the Shared Appreciation Agreement and
considered any capital improvements that voureported. Based onthis information, we have determined that vou owe
$12,333.00in SAArecapture.
FSA-2545 should be sent to all borrowers who have expired Shared
Appreciation Agreements.
Expiring Borrowers with expired Shared Appreciation Agreements must be
agreements are | notified of the recapture due using FSA-2545. Review borrower
serviced case-file documentation and discuss with FLM to determine
according to borrower’s response to notification.
5-FLP
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DD FLP Oversight Review User Guide (Continued)

E Part B: Semiannual Reviews (Continued)

2 Direct Loan Servicing (Continued)

B Classification of Borrower Accounts

Review requires a count of all accounts that should be classified during the current FY.
Information sources include the following:

e Dborrower case file

e discussions with Service Center

e OY FLPDM Classification Review Workflow Report

e QY FLPDM Direct Application Report.

Question Source
1: New Verify borrowers approved for new loans had classification reviews

Borrower |performed on their accounts.
accounts
are Compare Data Mart Direct Loan Making, OY FLPDM Direct Loan
classified |Application Report with the Direct Loan Servicing/Routine Servicing,

OY FLPDM Classification Review Workflow Report. Select the report
to cover the Service Center and specific review period dates. Save or print
both reports to use for comparison.

When pulling the Classification Review Workflow Report, select “In
Conjunction with a Loan Closing” to limit the search to Classification
Reviews only.

Note: Some borrowers may be listed on the Direct Loan Application
Report, but their loans may not have closed by the end of the period
covered by the report and may not; therefore, show up on the
Classification Review Workflow Report.

Discuss borrowers who were not classified with the Service Center.

2-3-14
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(Par. 442, 443)

E Part B: Semiannual Reviews (Continued)

2

2-3-14

Direct Loan Servicing (Continued)

B Classification of Borrower Accounts (Continued)

e “by Final Disp”
e “by Name”.

Question Source
1: New On the Direct Application Report Selection Page, using the drop-down lists,

Borrower |select the following and CLICK “Run Report”:

accounts

are e “State”, select applicable State

classified |e “District”, “All Districts”

(Cntd)  |e “County”, “All Counties”
e “Ethnicity” and CLICK “All” radio button
e “Status”, “Approved”
e “Race”, “All Races”
e “Gender”, “All Genders”
e “From” and “TO” dates and CLICK “Date by Range” radio button
e “Sort Selection™:

Direct Application Report Selection Page

Selection Criteria:

Hold the CTRL or SHIFT key down for Multiple Selections

State: District: Senvicing Office: County:

<==<3plect Statg===> - All Districts | » All Semvice Offices FS All Counties ES
Alabama a0 01-305 Tuscaloosa 01-004 Bibk

Alaska a02 01-308 Elmore (01-028 Fayette

Arizona 503 01-309 Coffee 01-032 Greene

Arkansas v 504 v 01-311 Lawrence A 01-033 Hale v

Ethnicity: Status: Race: Gender:

Al Al ~  [AIRaces ~|  [AGenders ~
0] H'SDE‘“_'C ; Approved Amer Indn/Alsk Natv Female

O Non-Hispanic Rejectsd v Asian v Male v
From: | octoper w1 |w| 2012 | © DatebyFiscal Year [ List Borrowers

) Date by Range

To: | March w31 w2012

Report Selection: Report Format:
c -
Stats Re|,..,rt. hd ) PDF Format
Sort Selection: ol r ) Excel Format
by Final Disp | & Ascending O Print

) Descending X .

O Hyperion Format

by Name | @ Ascending

O Descending Run Report

) Ascending -
hone Y| O Descending Reset Al
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E Part B: Semiannual Reviews (Continued)
2 Direct Loan Servicing (Continued)

B Classification of Borrower Accounts (Continued)

classified |e
(Cntd)

“Sort Selection™:

e “by Service Office:
e “by Borrower Name”.

Question Source
1: New On the Classification Review Workflow Report Page, using the drop-down
Borrower |lists, select the following and CLICK “Run Report”:
accounts
are e “Status”, “All”

Classification Review Workflow Report

Selection Criteria:

Hold the CTRL or SHIFT key down for Multiple Selections

State: District: Senvicing Office: County:
====3elect State==== ~ All Districts. All Service Offices ~ All Counties ~
01-501 01-3058 Tuscaleosa 01-004 Bibb
01-502 01-308 Elmore 01-029 Fayette
01-503 01-309 Coffee 01-032 Greene
01-504 01-311 Lawrence 01-033 Hale
California 01-313 Dekalb 01-038 Lamar
Colorado w w 01-317 Menroe L 01-053 Perry R
Status: Date:
Mot Completed - From: | October  |s||01 |s| 2012 (& Scheduled Date
Completed & Credit Action Date
3 Completed Date
Al - To[March  |w|[31 [v]2013 | o
Reason for Review:
All ~
Every Two Years
In Conjunction with a Loan Closing
In Conjunction with a YEA v

Sort Selection:
by Senvice Office v © Ascending
= ) Descending
T (& Ascending
by Borrower Name v & Descending
@ Ascending
Nane hé ) Descending

2-3-14 1-FLP (Rev. 1) Amend. 94
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E Part B: Semiannual Reviews (Continued)
2 Direct Loan Servicing (Continued)

B Classification of Borrower Accounts (Continued)

Question Source

2: FBP Borrower accounts may be accessed in DLS to view their specific
Updated/ classification review, determine that it has processed, and verify any
Transactions |questions or concerns about the borrower’s classification.
Processed

While on Service Center Dashboard, CLICK “lcon’ under “CR Header”
column and the Classification Review Dashboard will be displayed.

Reminders | Classification Peview

Pending Reminder Due Alert d

v Complete CR 09,/30/2010 02/02/2010 I @
Postponed Reminder 1
Closed Reminder Due Closed 1

CLICK “Classification Review” tab to access the Classification Review
process, allowing a more detailed view of the classification activities
performed on that account.

Reminders | Classification Review |
Active Reviews
Creation Date Activity Summary
2 07/17/2009 Classification Review

2 Classification Rewview
Previous Reviews

~ Completion Date  Activity Summary
@ 0s/12/2009 Classification Review
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E Part B: Semiannual Reviews (Continued)

2 Direct Loan Servicing (Continued)

B Classification of Borrower Accounts (Continued)

Question Source
3: Annual From the Classification Review Workflow Report Screen, create a report
classification | for the review time period. Using the drop-down lists, select the
of existing |following and CLICK “Run Report”:
borrower
accounts e “Status”, “All”

e “Date”, “From” and “To”, select date range for Classification
Reviews that have not been completed and CLICK “Scheduled
Date” radio button

e “Reason for Review”, “All”
e “Sort Selection”:

e “by Service Office”
e “by Borrower Name”
e “by Workflow Completion Date”.

Document the number of classification reviews that need to be completed
by the end of review period. Discuss with Service Center the plan to
complete any reviews that will need to be completed by the end of the
year.

Notes: For questions about classifying borrower accounts, see to Part 8,
Section 4.

These instructions demonstrate pulling reviews scheduled for the
current review period. To include all reviews that should have
been completed before the current timeframe, change the From
date to further in the past and select a status of “not completed”.

2-3-14
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E Part B: Semiannual Reviews (Continued)
2 Direct Loan Servicing (Continued)

B Classification of Borrower Accounts (Continued)

2-3-14

1-FLP (Rev. 1) Amend. 94

Question Source
3. Annual e .
e . Classification Review Workflow Report
classification
Of eX|st|ng Selection Criteria:
borrower State: District: Semicing Office: County;

«==<Sglect State==»= | |All Districts || | All Service Offices A [All Counties A
accou_nts Alabama 01-501 01-305 Tuscaloosa 01-004 Bibh
(Continued) || |4iaska 01-502 01-308 Elmore 01-029 Fayette

Arizona 01-503 01-308 Coffes 01-032 Greene

Arkansas 01-504 01-311 Lawrence 01-033 Hale

California 01-313 Dekalb 01-038 Lamar

Colorado v »| [01-317 Monroe v | 01-083 Perry v

Status: Date:

Nat Completed Py From: | Octsber |w| 01 |v|2012 @ Scheduled Date

Completad C‘ Credit Action Date

) Completed Dat

Al . To: | Harch wl31 [l 2013 (O Completed Date

Reason for Review:

Al A

Every Two Years

In Conjunction with a Loan Clasing

In Conjunction with a YEA v

Hold the CTRL or SHIFT key down for Multiple Selections

Sort Selection: Report Selection:
by Senice Offce v © Ascending © PDF Format
( Descending () Excel Format
: ) Print
by Barrower Name v g ';Seieclﬂdniig (3 Hyperion Format
o Run Report
S arl e O - Ascending
by Worlflow Completion Date v O Descending ReselAl
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E Part B: Semiannual Reviews (Continued)
2 Direct Loan Servicing (Continued)
C Year End Analysis

Review requires a count of all accounts that will require YEA during the current FY.
Information sources include the following:

e discussions with Service Center
e OY FLPDM Year End Analysis Workflow Report.

Question Source
1: Number of |YEA’s are required for all accounts with:

analyses

required this [e new loans

FY e chattel subordinations

e PLS or DSA in the previous FY
o financially distressed or delinquent accounts
e accounts with limited resource loans.

Access from Data Mart, OY FLPDM Year End Analysis Workflow
Report for the review time period, to determine if reviews are being
completed as required.

Note: See to Part 8, Section 5, for questions about YEA’s.
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E Part B: Semiannual Reviews (Continued)
2 Direct Loan Servicing (Continued)

C Year End Analysis (Continued)

Date” radio button

e “Sort Selection”:

Question Source
1: Number of |On the Year End Analysis Workflow Report Screen, from the drop-down
analyses lists, select the following and CLICK “Run Report”:
required this
FY e “Status”, “All”
(Continued)

e “Date”, beginning of FY to current date and CLICK “Scheduled

e “Reason For Review”, “All”

e “by Service Office”
e “by Workflow Completion Date”
e “by Borrower Name”.

2-3-14

Year End Analysis Workflow Report
Selection Criteria:
State: District: Senvicing Office: County:
====3elect Statg==== ~ All Districts |~ All Service Offices ”~ All Counties S
Alabama 01-501 01-305 Tuscaloosa 01-004 Bibb
Alaska 01-502 01-208 Elmare 01-029 Fayette
Arizona 01-503 01-302 Coffes 01-032 Greene
Arkansas 01-504 01-311 Lawrence 01-033 Hale
California 01-312 Dekalb 01-038 Lamar
Caolorado o o 01-317 Monroe o 01-053 Perry o
Status: Date:
Mot Completed -~ From: |October |« |[01 |+| 2012 & Scheduled Date
Completed & Credit Action Date
All & Completed Date
- To! | September|s |30 |»| 2013
Reason For Review:
All ~
In Conjunction with Loan Clesing [] Completed by Contractor
In Conjunction with Loan(s)
Has Limited Resource Loan(s)
Received Primary Loan Servicing in the Past Year W
Hold the CTRL or SHIFT key down for Multiple Selections
Sort Selection: Report Selection:
by Service Office - @ Ascending & PDF Format
© Descending O Excel Format
; C Print
o - ’ ) Ascending . )
by Waorlflow Completion Date ~ = ' Hy,
¥ Comg O Descending > Hyperion Format
_Run Report
by Barrawer Mame - & Ascending —
Sl O Descending Reset All
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E Part B: Semiannual Reviews (Continued)
2 Direct Loan Servicing (Continued)

C Year End Analysis (Continued)

Question Source

2: Number of |When reviewing the Year End Analysis Workflow Report, count the
Analysis number of YEA’s that have been completed. Subtract that number from
completed |the total number of YEA’s on the report to determine how many remain
year to date |to be completed.

3: Number of

Analysis Discuss a plan to complete all required YEA’s with the Service Center.

needed to be A~

com p I etEd FLP Customer Response Credit Credit Workﬁob\
- h Mail Scheduled Contacted Received Action Action  Completed By / Completion

prlor to t € Code Sve Office Borrower Name Case Nbr Date Date Date Date Description ~ Contractor Date

end Of the 01-305 Tuscaloosa 0812912013 N

FY

01-305  Tuscaloosa 021312013 02132013 02132013 02132013 2012 Crop Year N 021512013

YEA

01305 Tuscaloosa 03132013 03152013 OAMSR013  O3MSI013 2135FLPand N 032012013

OL-Term

01305 Tuscaloosa 11512012 111512012 111512012 11152012 2013 Winter N 0411912013,

Wheat - Post Close

The final column of the report is completion date for YEA workflow.
Use the number of completed/noncompleted workflow items to answer
questions 2 and 3.

Note: To view YEA’s that should have been completed before the
current timeframe, change “Status” to “Not Completed” and the
date range as applicable.
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E Part B: Semiannual Reviews (Continued)
3 Guaranteed Loan Servicing
A Semiannual and Default Status Reports and Delinquent Loan Accounts

Review and discuss the reports with the FLM, FLO, and/or SFLO to complete review items.
Information sources include the following:

2-FLP, paragraphs 266 and 300
discussions with the Service Center
GLS Report Code GLS-2001

GLS Report Code GLS4265

GLS Report Code GLSSR02

GLS Report Code GLSSRO04.

Question Source

1. Status reportsand |GLS4265, Submitted Status Reports, displays the list of lenders
default status who have submitted a status report.
reports are received
from the lenders Access from GLS Reports, GLS Status Reports, GLS4265
Submitted Status Reports.

2: Statusreportsand | Discuss the office procedure for reviewing of status reports and
default status default status reports with FLM.
reports are reviewed
by FLM
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E Part B: Semiannual Reviews (Continued)

3 Guaranteed Loan Servicing (Continued)

2-3-14

A Semiannual and Default Status Reports and Delinquent Loan Accounts (Continued)

are received

Question Source
3: Statusreportsand |Report Code GLSSR02, Past Due Status and Default Status
default status Reports, displays status reports and default status reports that
reports are input were due and have not been recorded in GLS. This report lists
into GLS when they | past reports due by borrower.

Report Code GLSSRO04, Past Due Status and Default Status
Summary Report, summarizes the total number of lender
branches/loans with past due reports.

Discuss any reports that have not been input into GLS with
Service Center.

The following GLS Report GLSSR04 summarizes reports due.

CAALT2 United States Department of Agriculture
GLSSR02 FARN SERVICE AGENCY
PAST DUE STATUS AND DEFAULT STATUS REPORT

TOTAL NUMBER OF LENDER BRANCHES WITH STATUS REPORTS PAST DUE (::::)
TOTAL NUMBER OF LOANS WITH STATUS REPORTS PAST DUE

SERVICING STATE:

sIc 6RO BORR ID/  LOAN/  BORROWER NAME/ DATE REPORT REPORT LN
ST/CNTY ST/CNTY  LMRID  BRCH  LENDER NAKE OF LOAN TIPE DUE DATE  TYPE
51 D 11/10/2009  DEFAULT STATUS  06/07/2013 FO
001 BANK
CAALT2 United States Department of Agriculture PAGE 2
GLSSR04 FARM SERVICE AGENCY 07/17/2013
Past Due Status and Default Status Summary Report 13.27.15
Total Number of Lender Branches with Status Reports Past Due 9
Total Number of Loans with Status Reports Past Due 15
Number of Past Number of Past Due

Servicing State Due Status Reports  Default Status Reports

I3 2 13
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3 Guaranteed Loan Servicing (Continued)

A Semiannual and Default Status Reports and Delinquent Loan Accounts (Continued)

Question Source
4. FLP staff is following- |Discuss the follow-up actions being taken on each account that
up on servicing actions |is delinquent and/or has an anticipated loss claim with Service
for delinquent Center. List all delinquent accounts on this report.
accounts. FLM is
reviewing loss claims |Access from GLS reports, GLS2001, Lists of Delinquent
5: List delinquent Borrowers report. The report displays delinquent loan
accounts information by mail code for all loans past due.
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E Part B: Semiannual Reviews (Continued)

3 Guaranteed Loan Servicing (Continued)

B Lender Reviews

Review requires a count of loans or accounts for each type of lender. Information sources
include the following:

2-FLP, paragraph 267

discussions with Service Center
GLS Report Code GLS2003
record count from Operational Files.

Question

Source

Required Number of
SEL borrower files to be
reviewed for FY

Number of SEL
borrower files reviewed
year to date

Required number of CLP
borrower files to be
reviewed for FY

Number of CLP
borrower files reviewed
year to date

Required number of PLP
borrower files to be
reviewed for FY

Number of PLP
borrower files reviewed
year to date

Access from GLS Reports, GLS Status Reports Code
GLS2003, Guaranteed Loans by Lender Caseload.

Report lists guaranteed loan information by lender ID within
lender name, giving a total amount by lender.

Review and discuss the report with FLM, FLO, and/or
SFLO.

Review items:

e (1), (3), and (5) will be determined by the number of
borrowers for each lender, and the percentage required to
be reviewed based on lender status according to 2-FLP,
subparagraph 267 B.

e (2),(4), and (6) will be determined through discussion
with FLM, FLO, and/or SFLO.
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F Part C: Annual Reviews

Note: Use the “Review Area Comments” section to note issues on which to followup or other
comments relevant to the review.

1 Direct Loan Servicing

A Borrower Graduation

Review required for all borrower accounts classified as a “1” or “2”. Information sources
include the following:

e 4-FLPPart4

e discussions with the Service Center
e DLS Graduation Review Monitoring Report
e Operational Files.

Question

Source

1: Lender
surveys are
completed
annually

Each October, an authorized agency official shall contact local lenders to
obtain their underwriting criteria for making agricultural loans. A
summary of this information should be kept in the Operational Files.
Review to determine if this information was obtained.

For information about borrower graduation requirements, see 4-FLP,
Part 4.

Lender Agricultural Loan Underwriting Standards

Short-Term Credit

Lender | Lender | Lender | Lender | Applicant
Date Completed
Name
Lending Lt N/A
Mininum Loan Size N/A
Percent Equity

Percent Repayment Margin
Types of Security Required

Maximum Loan to Security Value N/A
Maximum Term of Loan

Information gathered from local lenders should be summarized on a table
such as 4-FLP, Exhibit 22 representing Short Term, Intermediate Term,
and Long Term Credit.
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F Part C: Annual Reviews (Continued)

1 Direct Loan Servicing (Continued)

2-3-14

A Borrower Graduation (Continued)

Question

Source

Graduation
potential for
borrowers is
documented
in each
borrower’s
case file and
the
operational
file as
appropriate

Graduation reviews should be conducted for all borrowers who classify
asa“l” or “2”.

From the Data Mart DLS Loan Servicing, Routine Servicing Reports,
select “OY FLPDM Graduation Review Monitoring Report”. From
the Graduation Review Monitoring Report Screen, create the report to
determine borrowers who classify as “1” and “2”, but have not yet had a
graduation review. Discuss with the Service Center to determine when
graduation reviews will be completed for these borrowers.

Notes: Answer “Yes” only if all required reviews have been completed
for the FY, and explain the Service Center plan of action to
complete the reviews.

Report can be set up to pull all Graduation Reviews “Not
Completed” (CLICK “Scheduled Date”) or “Completed”
(CLICK “Completion Date”) for the Service Center during the

current FY.
Graduation Review Monitoring Report
Selection Criteria:
State: District: Senvicing Office: County:
===<5glact State==== A | |All Districts |~ | [All Service Offices A | All Counties A
Alabama 01-501 01-305 Tuscaloosa 01-004 Bibb
Alaska 01-502 01-308 Elmore 01-028 Fayette
Arizona 01-503 01-309 Coffes 01-032 Greene
Arkansas 01-504 01-311 Lawrence 01-033 Hale
California 01-313 Dekalb 01-038 Lamar
Colorado v ¥ 01217 Manrna ¥ ln4.nsa parm: .
Status: Date:
Mot Completed -~ From: | October w01 |w| 2012 () Scheduled Date
Completed ) Completed Date
o To:| September s |30 [+| 2013
Sort Selection: Report Selection:
by Service Office v g .;scendig.g () PDF Format
$ Clezrzinll O Excel Format
O Print
= Ascending - )
i Celednled = Yy Hy
by Scheduled Date v O Descending ) Hyperion Format
o A i Run Report
= Ascending
by Borrower Name A O Descending Reset Al
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1 Direct Loan Servicing (Continued)

A Borrower Graduation (Continued)

Discuss the status of any borrower that has been asked to graduate with

the Service Center.

Question Source

3: Follow-up is | Borrower accounts that are determined eligible for graduation will be
completed |submitted to local lenders using a borrower prospectus similar to 4-FLP,
for Exhibit 24.
borrowers
who are 4-FLP, Exhibit 24 is used to determine local lender interest in refinancing
asked to a specific operation.
graduate

Dear:

and consideration:

Name

2-3-14

(Use Agency Letterhead format with local return address.)

BORROWER PROSPECTUS

FSA is required to determine if direct loan applicants can obtain commercial credit with an FSA loan guarantee.
Also, FSA direct loan borrowers must be referred to commercial lenders for guaranteed or nonguaranteed
financing when they appear to meet the lending criteria of a cross-section of local lenders.

Your institution is among those that asked to receive prospectus information on all such FSA applicants and
borrowers. Therefore, we have attached financial summary information on the following borrower for your review

Estimated

Needed

Eligible for Total Amount
FSA Loan Existing FSA Term  Production Loan
Guar. Loan(s)
YES NO

1-FLP (Rev. 1) Amend. 94

4-FLP, Exhibit 24

Lender Use

Do Not
Refer Refer
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1 Direct Loan Servicing (Continued)

A Borrower Graduation (Continued)

Question Source

3: Follow-up is | If lenders exhibit interest in refinancing, the borrower is provided with a
completed |letter similar to 4-FLP, Exhibit 25, instructing them to begin the process
for of refinancing the FSA debt.
borrowers
who are 4-FLP, Exhibit 25 is used to notify borrowers that lenders are interested
asked to in refinancing their FSA debt. Borrower responses to this letter should
graduate be documented in the borrower case file.
(Continued)

4-FLP, Exhibit 25
(Use Agency Letterhead format with local return address.)
LETTER TO NOTIFY BORROWERS TO REFINANCE THEIR FSA INDEBTEDNESS
Dear:
The financial progress you have made since receiving your Farm Service Agency (FSA) loan(s) has been
reviewed. You should take pride in the progress you have made. We share that pride with you and are pleased

that we may have been of service.

Your FSA loan and security instruments require you to refinance the unpaid balance of your loan(s), when you
have progressed to the extent that you can obtain credit from responsible cooperative or commercial lenders.

Lenders have been contacted to determine their requirements and the availability of credit to new customers. We
have evaluated your financial progress, together with the lender requirements, and find that you should now be
able to secure satisfactory credit to pay your FSA loan(s). Therefore, we request that you refinance your [Enter
type of loan, FO, OL, etc] loan(s) in full.

This approximate balance is $
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F Part C: Annual Reviews (Continued)

1 Direct Loan Servicing (Continued)

B Subordinations

Review all accounts with outstanding subordinations. Information sources include the

discussions with Service Center
DLS Outstanding Subordination Report

following:

e A4-FLP Part 6

e Dborrower case files
[ J

[ J

[ J

DLS Subordination Request Report.

Question Source
1: Borrower From the Data Mart DLS Loan Servicing, Routine Servicing Reports,
Name select “OY FLPDM Outstanding Subordinations Report”. From the
2: FLPstaffis |Outstanding Subordination Report Screen, create the report to generate a
monitoring  [list of all borrowers with outstanding subordinations.
outstanding
subordination | Discuss all outstanding subordinations with the Service Center to ensure

that the accounts are being monitored and serviced.

Note: The following example report is set to provide information for a
single Service Center. The report will contain information for all
outstanding subordinations.

Qutstanding Subordinations Report
Selection Criteria: Hold the CTRL or SHIFT key down for Multiple Selections
State: District: Semvicing Office: County:
<==<3glect State==== ES All Districts |~ All Service Offices ~ All Counties A~
Alabama 01-501 01-305 Tuscaloosa 01-004 Bibh
Alaska 01-502 01-308 Elmore 01-023 Fayette
Arizona 01-503 01-209 Cofiee 01-032 Greene
Arkansas 01-504 01-311 Lawrence 01-033 Hale
California 01-213 Dekalb 01-038 Lamar
Colorado 01-317 Monroe 01-0583 Perry
Connecticut 01-054 Pickens
Delaware s b hd 01-060 Sumter hd
Sort Selection: Report Selection:
by Service Office v © Ascending & PDF Format
© Descending 3 Excel Format
O Print
N ) & Ascending = o
by Borrower Mame w O Descanding > Hyperion Format
Run Report
None - & Ascending
s  Descending Reset All
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F Part C: Annual Reviews (Continued)

1 Direct Loan Servicing (Continued)

2-3-14

B Subordinations (Continued)

document has
been returned
marked

“paid-in-full”

Question Source

3: Matured From the Data Mart DLS Loan Servicing, Routine Servicing Reports,
loans have select “OY FLPDM Subornation Request Report”. From the
been paid off |Subordination Request Report Screen, create the report for the current
and the FY to determine any subordination that has been paid-in-full during the
original year. For all subordination requests made during the current FY select
subordination |the following and CLICK “Run Report”:

e “Status”, “All”
e “Security Type”, “All”

e “Date”, “From” and “To”, select all FY to date and CLICK
“Request Date” radio button

e  “Sort Selection”:

e “by Service Office”
e “by Borrower Name”.

Subordination Request Report

Selection Criteria: Hold the CTRL or SHIFT key down for Multiple Selections
State: District: Senvicing Office; County:

====5glect State==»== ~ All Districts |~ All Service Offices ~ All Counties ~
Alabama 01-501 01-305 Tuscaloosa 01-004 Bibb

Alaska 01-502 01-208 Elmore 01-029 Fayette

Arizona 01-5032 01-209 Coffee 01-032 Greene

Arkansas 01-504 01-311 Lawrence 01-033 Hale

California 01-313 Dekalb 01-038 Lamar

Colorado b b 01-217 Monroe o 01-053 Perry ~
status: Secunty |vpe:

Mot Completed [~] All -~

Completed Crops Only

All Livestock Cnly

~ IMachinery Gnly ~

Date:

From: | Octoher || 1 - R_EqUEstDah_a_
> Final Disposition Date

& Expiration Date
e Septembe v | 30 || 2013

Sort Selection: Report Selection:
by Service Office v ? .;scendig.g & PDF Format
B [B=Esue i, 3 Excel Format
O Print
e A & Ascending - .
by Borrower Name b O Descending > Hyperion Format
Run Report
None = ) Ascending
- & Descending Reset All

1-FLP (Rev. 1) Amend. 94 Page 79



Exhibit 36
(Par. 442, 443)

DD FLP Oversight Review User Guide (Continued)

F Part C: Annual Reviews (Continued)
1 Direct Loan Servicing (Continued)

B Subordinations (Continued)

Question Source

3: Matured loans  |Ensure that the original subordination document was marked
have been paid |paid-in-full and returned.
off and the
original The final column of the report indicates the date the subordination
subordination  [was paid-in-full.
document has
been returned
marked
“paid-in-full”
(Continued)
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F Part C: Annual Reviews (Continued)

1 Direct Loan Servicing (Continued)

2-3-14

C Chattel Security Accounting

Review a sample of 5 borrower accounts; review all if less than 5. Review more files if
deficiencies are found. Information sources include the following:

borrower case file

discussion with Service Center officials

DLS Borrower Financing Statement Combined Reports

DLS Farm Visit Workflow Report

OY FLPDM Status of Farm Loan Programs 540 (Routine Servicing).

Question

Source

1: Borrower
Name

Select 5 chattel-secured borrowers at random from Data Mart Direct
Loan Servicing/Routine Servicing, OY FLPDM Status of Farm Loan
Programs (540) Report.
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1 Direct Loan Servicing (Continued)

2-3-14

C Chattel Security Accounting (Continued)

Question Source

UCC filings |From the Data Mart DLS Loan Servicing, Routine Servicing Reports,
have been select “OY FLPDM Borrower Financing Statement Combined
properly Report”. From the Borrower Financing Statement Detail/Monitoring
continued or |Report Screen, create the report for a specific borrower selected from
amended as  |the 540 report. To create a report for a specific borrower select the
applicable following and CLICK “Run Report”:

and the

management |e “Status”, “All”

system has

been updated
for correct
follow-up
date

e “Date”, “From” and “To”, desired range and CLICK “No Date
Selected” radio button

e “Report Selection”, CLICK “Detail Report” radio button

e “Borrower”, locate and select the borrower.

Borrower Financing Statement Detail/Monitoring Report

Hold the CTRL or SHIFT key down for Multiple Selections
Selection Criteria:
State: District:

====Jelect State==== -

Senicing Office; County:
All Service Offices -

01-004 Bibb

Alaska 01-308 Elmore 01-028 Fayette
Arizona 01-309 Coffee 01-032 Greene
Arkansas 01-311 Lawrence 01-033 Hale
California 01-313 Dekalb 01-038 Lamar
Colorado - - 01-317 Monroe - 01-053 Perry -
Status: Date:
Active . From: | January v|'1 - |2013 © Mo Date Selected
Terminated E':"_T Dt_ate ot
o piration Date
To: | March v|3‘1 - |2013
Report Selection: Borrower. [All Borrowers ~
04 pL

@ Detail Report

I gt
Maonitoring Report ' R
|

Sort Selection: Report Selection:
|bySerwce Office v| Q) GEIEINTY ¢ PDF Format
Descending Excel Format
’ Print
|N0ne v| o Ascendln.g Hyperion Format
Descending
Run Report
|N0ne v| @ Ascending
Descending ResetAll
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F Part C: Annual Reviews (Continued)
1 Direct Loan Servicing (Continued)

C Chattel Security Accounting (Continued)

Question Source
2: UCCfilings |Review the resulting Borrower Financing Statement Detail Report to see
have been if the borrower select has:

properly

continued or |e financing statements that are in need of continuation

amended as

applicable  |e expired financing statements

and the

management |e  followup dates (displayed on the screen as “Alert Date”) listed for
system has the next action on the financing statement.

been updated
for correct Report will indicate the last filing/continuation date and the next

follow-up  |expiration date.
date
(Continued) UNITED STATES DEPARTMENT OF AGRICULTURE
FARM SERVICE AGENCY
DIRECT LOAN SERVICING
Borrower Financing Statement Detail Report
Jatus: All
u[g T
jsinct. All Districts
rvice Office:
umnty’ All Counties
b Date Selected
T sticty  Sec
Mail Security Filing Filing Where Instr Alert Expiratior
Lode rvicing Otfice Borrower Name Case Nbr Instrument Number Date Eilled Iype Date Date
e L Onginal 06-0716251 08152006 01000  CFS 02152016 085201
Continuation 06-071825 08022011
L Original 11.0355381 08022011 01000  CFS 02022016 0&/02201)

SECURITY INSTRUMENT TYPE:

UCC . Uniform Commercial Code
CFS - Centralized Filing System
EFS - Effective Filing System
FF5 - Fixture Filing Statement
MVL - Molor Vehicle Lien

IML - In-Lieu Financing Statameant
€ e {Jfifl?-
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1 Direct Loan Servicing (Continued)

2-3-14

C Chattel Security Accounting (Continued)

Question

Source

Annual
inspections of
chattels are
completed as
required

e “Status”, “All”

e “Visit Type”, “Chattel Inspection”

From the Data Mart DLS Loan Servicing, Routine Servicing Reports,
select “OY FLPDM Farm Visit Workflow Report”. From the Farm
Visit Workflow Report Screen, create the report for Chattel Inspections
to determine if chattel security has been inspected this year. To create

the report for chattel inspections only, select the following and CLICK
“Run Report”:

e “Date”, “From” and “To”, select desired range and CLICK
“Scheduled Date” or “Completion Date” radio button.

None

v‘

() Descending

() Ascending
O Descending

Farm Visit Workflow Report
Selection Criteria: Hold the CTRL or SHIFT key down for Multiple Selections||
State: District: Senicing Office: County:
zz=<3elect States=»» A All Districts | & | All Service Offices A~ |All Counties A
Alabama 01-501 ‘ 01-305 Tuscaloosa [ 01-004 Bibb
Alaska 01-502 01-308 Elmore 01-029 Fayette
Arizona 01-503 01-309 Coffee 01-032 Greene
Arkansas 01-504 01-311 Lawrence 01-033 Hale
California 01-313 Dekalb 01-038 Lamar
Colorado v v | |01-317 Monroe v | |01-053 Perry v/
Status: Visit Type:
Not Completed Al All ol
Completed = Chattel Inspection B
Al Crop Inspection
b Development Inspection v
Date:
From: |October w01 |v|[2012 () ScheduledDate .
4 {0 O Completion Date [ completed by Contractar
To: Septembe v 30 |wl]2013
Sort Selection: Report Selection:
by Senice Office v| © Ascending () PDF Format
; O Descending ) Excel Format
: v ; O Print
| by Borrower Name v (2 fecis

O Hyperion Format

Reset All
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F Part C: Annual Reviews (Continued)
1 Direct Loan Servicing (Continued)

C Chattel Security Accounting (Continued)

Question Source

3: Annual The Chattel Inspection Report will indicate date of completed or
inspections of |scheduled inspections, based on selection made on the Farm Visit
chattels are | Workflow Report Screen.
completed as
required Discuss with Service Center the plan for ensuring chattel security is
(Continued) |accounted for on inspections that have not been completed.
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F Part C: Annual Reviews (Continued)

1

2-3-14

Direct Loan Servicing (Continued)

D Limited Resource Reviews
Review 5 limited resource borrower accounts; review all if there are less than 5.
Information sources include the following:

o A-FLP, Part3

e borrower case file

e DLS Limited Resource Review Monitoring Report

e documentation, discussion with Service Center officials.

Question Source
1. Borrower From the Data Mart DLS Loan Servicing, Routine Servicing Reports,
Name select “OY FLPDM Limited Resource Review Monitoring Report”.

From the Limited Resource Review Monitoring Report Screen, create
the report for all completed reviews. Report options can be changed to
provide all “Status”, “Completed”, or “Not Completed” reviews.

Limited Resource Review Monitoring Report

Selection Criteria:
State: District Senicing Office: County:
<x2=3glect State=»»» A |AllDistricts || [All Senice Offices | |AllCounties A
Alabama 01-501 01-305 Tuscalonsa 01-004 Bibb B
Alaska 01-502 01-308 Elmare 01-029 Fayette
Arizona 01-503 01-309 Coffee 01-032 Greene
Arkansas 01-504 01-311 Lawrence 01-033 Hale
California 01-313 Dekalb 01-038 Lamar
Colorado v v/ |01-317 Monroe v| |01-053 Perry v
Status: Date:
Not Completed A Fom: ocober |v|01 |wf2012 O ScheduledDate
Completed El ; () Completed Date
- To: | Septembe w30 |w 2013

Hold the CTRL or SHIFT key down for Multiple Selections

Sort Selection: Report Selection:
by Senice Offce v| © Ascending () PDF Fomat
‘ O Descending () Excel Format
O Print

0y Ascendi
© Ascending O Hyperion Format

by Borrower Name v
Bk ! () Descending

: Run Report
() Ascending

None vl A
‘ - () Descending Reset Al
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F Part C: Annual Reviews (Continued)

1 Direct Loan Servicing (Continued)

D Limited Resource Reviews (Continued)

Question Source

2: Analysisis |Using the Limited Resource Review Monitoring Report, view all
completed reviews that were completed or not completed during FY. After
and continued | creating the report for “Completed” reviews, create a second report for
need for LR [reviews “Not Completed”.
rates is
documented |Discuss with Service Center any reviews that have not been completed.
in the
borrower case | Examine borrower case files to ensure that analysis documentation and
file limited resource rate determination has been made as part of all limited

resource rate reviews.

Review 4-FLP, Part 3 and discuss with Service Center if there are issues
with their determination.

Page 1
07712013

UNITED STATES DEPARTMENT OF AGRICULTURE

FARM SERVICE AGENCY B
DIRECT LOAN SERVICING '
Limited Resource Review Monitoring Report
alUs Nof Compleled
late:
Istict All Distncts

ervice Office: Al Servicing Offices
ounty All Counties
cheduled Date: 10/012012 - 0913072013

FLP Current
Mail FdCdl  Date Loan Interest Scheduled  Effective  Completed
Code  Sve Offies Borrower Name CaseNbr |nNo  Closed LoanAmount  Rate Flags Date Date Date
Y T8 0622013
Y 4 PLS 092002013
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F Part C: Annual Reviews (Continued)

2 Program Delivery

A Supervised Bank Accounts

Review all borrower files with supervised bank accounts. Information resources include the

following:

FSA-2140
FSA-2142
notices.

borrower case file running record
discussion with the Service Center

Note: SBA is an approved abbreviation in 1-CM, Exhibit 102 that stands for “Small
Business Administration”; however, because of software programming, SBA in the

following table stands for “Supervised Bank Accounts”.

Question

Source

1: Borrower Name

FSA-2142.

by FLM/FLO

2: The need for an SBA is documented

presentation.

Borrower case file running record and FBP credit

use of the SBA

3: Borrower has consented to continued

1-FLP, subparagraph 101 B and FSA-2140.

in borrower case file

4: DD or State Office has documented
concurrence or non-concurrence with
the use of an SBA and the reasons record.
for concurrence or non-concurrence

1-FLP, subparagraph 101 C and DD
documentation in borrower case file running

2-3-14
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F Part C: Annual Reviews (Continued)
2 Program Delivery (Continued)

B Program Promotion

Meet with 2 to 4 randomly selected borrowers and/or guaranteed lenders to ascertain the

quality of program delivery in the Service Center.

Question

Source

1: Met with 2-4 randomly selected borrowers and/or
guaranteed lenders to ascertain the quality of
program delivery in the Service Center.

Discussion with borrowers and/or
lenders. Borrower case file
documentation required.

2-3-14 1-FLP (Rev. 1) Amend. 94
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G Part D: Additional Reviews

Note: This section is mandatory for all Service Centers that had FLPRA or COR reviews.

1 “Farm Loan Program Risk Assessment (FLPRA) Reviews”

Mandatory to be completed within 1st quarter following the FLPRA review.

Question Source
1. Date of FLPRA Review | All review scores are entered in the FLPRA database along with
by State Office the review date.
2: Date findings were This date may or may not be the review date entered in FLPRA
discussed with FLP database. Check with the Service Center or State Office for this
staff date if not present when discussed.

DD should be a part of the State FLPRA process for Service Centers they oversee by:

e Dbeing present when reviews are conducted and the findings are discussed with the FLP office
e annually reviewing FLPRA scores to be aware of the risk and potential risk of these offices.

Follow these steps to access Service Center FLPRA scores.

Step

Action

1

From the Farm Loan Programs Systems Main Menu, under “Applications”, CLICK
“Risk Assessment FLPRA”.

USDA United States Depariment of Agriculiure ; - I': \ ]
Sl FSA - Farm Loan Programs Systems 5 =7

Applications Farm Loan Programs Systems Main Menu

Direct Loan System
- Direct Loan Making

- Direct Loan Servicing | welcome to the Farm Loan Programs (FLP) Systems.

eDALR:
T :usi Plan This is your centralized Farm Loan Programs (FLP) Systems. After all systems are

fNess operational, you will be able to make and service your clients' applications and loans from
Guaranteed Loan this site. It has been designed to streamline the overall process of managing your clients'
System portfolios by eliminating the need to input the same data into multiple systems. It will
Reports |nc0rporate direct links and system interfaces into other systems to reduce the chance of

el S eEe e will allow for all levels of reporting from a central location.

(FLPRA)

Questions and comments about the site can be referred to the FLPS Web Team.

2-3-14
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1
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“Farm Loan Program Risk Assessment (FLPRA) Reviews” (Continued)

Step Action
2 | The Welcome To The FLPRA Reports Screen will be displayed. Under “FLPRA”,
“Scoring”, CLICK “Completed Review Report”.
Welcome To The FLPRA Reports
Farm Loan Programs Risk Assessment:
National Reports Please make a selection from the menu on the left.
p
State Reports
Scoring
Completed Review Report =
3 | The Completed Reviews of Service Centers — Selections Screen will be displayed. Use

the following and CLICK “Submit”:

e “From” and “To” drop-down lists to select dates
e “State” drop-down list to select applicable State.

Exit FLPRA E-Forms ContactUs Search Local Offices USDA Home Help L
FLPRA Completed Reviews of Service Centers - Selections

Maintainenance
SELECT REVIEW DATES (optional)
FROM ISeIect leeIectleelectj TO ISeIect leeIectleelectj

National Reports Month Day Vear Month Day e
State Reports STATE IAIabama |

Scoring
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Exhibit 36

(Par. 442, 443)

G Part D: Additional Reviews (Continued)

1

2-3-14

“Farm Loan Program Risk Assessment (FLPRA) Reviews” (Continued)

Step

Action

4

State Reports

Scoring

Maintainenance

National Reports

The following screen will be displayed. Use the following and CLICK “Submit”:

e “Service Center” drop-down list to select the office being reviewed
e “Report Output” radio button to select PDF or Excel report format.

Exit FLPRA E-Forms Contact Us Search Local Office

FLPRA TO

12-31-2013
STATE Alabama
SERVICE ALL Service Centers [
CENTER

Report Qutput:

o Formatted for Printing (PDF)
[ Download to Spreadsheet (Excel)
Submit |

In the following example Excel format report, the FLPRA review date is displayed.

U.S. DEPARTMENT OF AGRICULTURE
FSA - FARM LOAN PROGRAMS
COMPLETED REVIEW OF SERVICE CENTERS
PREPARED: Jan 24, 2014 10:21:02 AM

1-FLP (Rev. 1) Amend. 94

CLASSIFICATION
SVCG | SERVICE LAST
OFC CENTER REVIEW
STATE | CODE CITY COUNTY DATE FI PO PM CS
Any Any
2z 1234 town County 9/14/2009 2 2 2 2
Any Any
1234 town county 7/23/2013 2 2 2 2
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Exhibit 36
(Par. 442, 443)

DD FLP Oversight Review User Guide (Continued)

G Part D: Additional Reviews (Continued)
Note: This section is mandatory for all Service Centers that had FLPRA or COR reviews.
2 “County Operations Reviews”

Mandatory to be completed within 1st quarter following the COR review.

Question Source

1: Date of COR Review Check with the Service Center or State Office

for the date if not present for review.

2: Date findings were discussed with FLP Check with the Service Center or State Office
staff; strategy developed for correcting for the date if not present when discussed.
deficiencies and preventing further
occurrences of review findings

DD should be:

e apart of the COR process for the Service Centers they oversee
e present when COR review is conducted and the findings discussed with the FLP office.

H Part E: Certification District Director Signature
Certify oversight reports by entering the following:

e DD’s signature
e DD’s name
e date signed.

Note: Oversight reports are locked when DD or proxy submit the report or after the due date,
whichever comes first, and does not allow anyone to add, modify, or delete review
information.
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Exhibit 36
(Par. 442, 443)

I Example of Completed Oversight Report

The following is an example of a completed oversight report.

F.eport Print Page

Repornt Generated On: 222013

Pagel of @

FSA 2101 U.5. Department of Agriculture

Farm Service Agency

DD FLP OVERSIGHT REPORT GUIDE
First Quarter Report
For Reviews Completed for the Period of 10012011 through 12/31/2011.
{District Oirector should complete this review before 1/21/2012 )

1.5TATE 2.DISTRICT HUMBER 3.5ERVICE CENTER

D-01 1 3ervice Center

4.FISCAL YEAR

2012

Part A. Quarterly Review 1. Direct Loan Making : Review Of Direct Loan Applications
A. Complete/Approved Application File Reviews

1. Applicant Name
2. Applicant representation is consistent within all FSA programs (&pplicant has not applied for or received Agency
benefits under any other name, entity or identifiation number)
3. Applicant was notified of receipt of complete application
4, Applicants were notified within 5 days of an eligibility determination
5. Appropriate environmental assessment completed
6. If application was held over 45 days without a loan decision, was a reason entered in DLS?
7. Credit dedsion (approval) was made within 80 days of receipt of complete loan application
(1) (2) (3 (4 (5) (6) (7
T - Tes Yes Tes Tes NA Tes
Tes Yes Tes Tes NA Tes
) Tes Yes Tes Tes NA Tes
. Yes Yes Yes Tes NA Yes
Tes Yes Tes Tes NA Tes

Part A. Quarterly Review 1. Direct Loan Making : Review Of Direct Loan Applications
B. Incomplete Application File Reviews

1. Applicant Name
2. Required notifications were sent to applicants within required timeframes
3. Items needed for a complete application are deary identified in notifications
4, Applicants are notified of required due dates for items needed for complete application
(1) (2) (3) (4)
. Tes Tes Tes
Tes Tes Tes
) Tes Tes Tes

Part A. Quarterly Review 1. Direct Loan Making : Review Of Direct Loan Applications
C. Withdrawn Application File Reviews

1. Applicant Name
2. SDA

3. Reason for the withdrawal of application is clearly documented

2-3-14 1-FLP (Rev. 1) Amend. 94
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Exhibit 36
(Par. 442, 443)
DD FLP Oversight Review User Guide (Continued)

I Example of Completed Oversight Report (Continued)

Feport Print Page Pagel of O
4. A complete application was received?
5. If a complete application was not received, an effort was made to abtain a complete application
6. ECOA and non-discnimination statements have been included in comrespondence to applicant
(1) (2) (3 (4 (5) (6)
) Yes Yes No Yes Yes
Yes Yez No Yes Yez
Yez Yez No Ye= Yez

Part A. Quarterly Review 1. Direct Loan Making : Review Of Direct Loan Applications
D. Rejected Application File Reviews

. Applicant Name
2. SDA
3. Reaszons for denial including applicable citations of requirements from (FR =edtions are dearly documented in the
naotification |letter to the applicant
Appropriate review/appeal nghts were included in the notification letter to the applicant according to 1-4FF
5. EO2A and non-discnimination statements were induded in the notification letter to the applicant acoording to 1-FL

(1 (2) (3 (4 (5)
B No Tes Tes Tes
No Tes Tes Tes

Part A. Quarterly Review 2. Guaranteed Loan Making : Review Of Guaranteed Loan Applications

appropriate appeal/review rnights were provided

8. Appropriate environmental assessment completed

7. Processing times are within timeframes prescribed in 2-FLP for lender type

1. Applicant Name

2. Lender Name

3. Lender Type

4. Applcant representation s consistent within all F5A programs (Applicant has not applied for or received Agency
benefits under any other name, entity or identifiation number)

5. Lender was notified of incomplete and/or complete application within timeframes prescrbed in 2-FLP

6. Eligibility of borrower and loan purposss have been evaluated; denial/withdrawal are thoroughly documented anc

(1) (2 (3) (4 (5) (6) (7) (8)

) Federal Land Bank PLP Tes Yes Tes Tes Tes

-_ . ’ Federal Land Bank PLP Tes Tes Tes Tes Tes
- Bank PLP Tes Yes Tesz Tez Tez

Farm Cr=dit PLP ez Yez Yez YTez YTez

|. Borrowers With Loans 90 Days Or More Past Due

Part A. Quarterly Review 3. Direct Loan Servicing A. Delinquent Account Servicing

1. Bormrower Name

past due.

2. PLS history report indicates a PLS notice was sent within 15 calendar days of bomrower's account becoming 90 da

2-3-14

1-FLP (Rev. 1) Amend. 94
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Exhibit 36
(Par. 442, 443)

DD FLP Oversight Review User Guide (Continued)

Example of Completed Oversight Report (Continued)

Feport Print Page Page3 of @

3. Offset notice was sent at the same time as the PLS notice (required when account is in monetany default)
4. Enter anticpated resolution
5. Entertarget date for resolution of delinguency

(1 2 6 (5
L. . Yes |Yes |3- Other: enter explanation in comments 03/31/2012
Yes |Yes |1-Borrower to pay cutrent: enter source of funds in comments 02,/20/2012
Yes |Yes |1-Borrower to pay cutrent: enter source of funds in comments 01/18/2012
e - Yes (Yes |3- Other: enter explanation in comments 03/30/2012
No |NA |3- Other: enter explanation in comments 02/29/2012

Part A. Quarterly Review 3. Direct Loan Servicing A. Delinquent Account Servicing
Il. Borrowers With Loans Less Than 90 Days Past Due

1. Borrower Name
2. Delinguency can be resclved before account enters 90 days past due
3. Anticipated Resolution
4. Target Date for resolution of delinquency
(1) (2 (3 4
' Yes  |Borrower to pay sccount currant 01042012
Yes  |Borrower to pay sccount currant 02403/2012
. Yez  |Borrower to pay account cutrent. 02/10v2012
No Borrower to pay account cutrent. 03/30/2012
Yez  |Borrower to payaccount current. 03/27/2012
No Borrower to pay account current 05/25/2012
Tez  |Borrowsr to payaccount cutrent. 01/18/2012
- Yez  |Borrower to payaccount current. 01/18/2012
Yez  |Borrower to pay account current. 01/18/2012
No Borrower to pay account current 06/20/2012
No Borrowsr to payaccount current 09:/07/2012
) Yez  |Borrower to payaccount current 03/29/2012
- Yez  |Borrower to pay account current. 03/01/2012
) Yez  |Borrower to payaccount current 02/27/2012
) Yes  |Borrower to pay sccount currant 03/01/2012
Tez  |Borrowsr to payaccount cutrent. 02/17/2012
No Borrowsr to pay account cutrent. 03/30/2012

Part A. Quarterly Review 3. Direct Loan Servicing A. Delinquent Account Servicing
lll. Borrowers With Loans That May Require Attention

1. Bormrower Name
2. Acoount Flag
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Exhibit 36
(Par. 442, 443)

DD FLP Oversight Review User Guide (Continued)

Example of Completed Oversight Report (Continued)

F.eport Print Page Paged of @
3. Payments are being made and are current according to an approved plan or agreement
4, Acoounts are serviced acoording to applicable regulations and/or handbook instructions
(1) (2 (3 4
- . SAA (Subject to Approved Adjustment) Tes  |Yes
SAA (Subject o Approved Adjustment) Yez |Yes
) SAA (Subject to Approved Adjustment) Tes  |Yes
) BAP (Banbruptey Action Pending) Tes  |Yes
. ACL (Accelerated) No  |Ves
BAP (Bankruptey Action Pending) Yez |Yes
. CAP(Court Action Pending) No Tes
ACL (Acceleratad) No Tes
[ ACL (Accelerated) No  |Ves
N BAP (Banbruptey Action Pending) Tes  |Yes

Part A. Quarterly Review 3. Direct Loan Servicing B. Payments And Collections

1. Bomrower/Acoount Name.(If collection was not made at this service center,also add the county name where
collection was made.)
2. Paymentis) and collections are applied within prescrbed time frames
3. Payment(s) are credited to the account(s) of the correct bormower
4, Payment(s) are applied to the borrower's loans acoording to 4-FLF
5. There is a proper separation of duties among emplovees handling transactions
| (1) i2) (3 i4) (5)
- Yes Yes Tes Yes
Tes Tes Tes Tes
Yes Tes Tes YTes
. Tesz Tez Tes Tesz
Yes Tes Tes YTesz

Part A. Quarterly Review 3. Direct Loan Servicing C. Chattel Security Accounting

1. Bormrower Name
2. Dispositions and proceeds are recorded on FSA-2040
3. Funds are released in accordance with the FBP and FS& regulations as applicable
4, Wark copy Security Agreement has been notated for any changes in oollatersal
5. FLM follows up on all apparent unauthorized dispositions; using Exhibit 31 to notify borrowers in all cases and
obtains adequate documentation to enable post approval where applicable
| (1) (2) 13 (4 (5)
. Yes Yes Yes NA
Yes Tes Tes NA
) Yes Yes Yes NA
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(Par. 442, 443)
DD FLP Oversight Review User Guide (Continued)

I Example of Completed Oversight Report (Continued)

F.eport Print Page Page3i of 9
Tes Tes Tes MA
Tes Tes Tes A

Part A. Quarterly Review 4. Program Delivery FLP Goals : From FLP goals established by the National
Office for your state

1. FLP Goal

2. State Goal

3. Service Center Goal

4. FLP Staff Progress

(1 2 (3 4

First vear delinquency rate on new loans (%) 3.0 0 0
Direct loan processing ime ( Days) 30 0 0
Guarantesd loan processing time [ Davys) 12 0 0
Lending to beginning farmers and ranchers (¥3) 27.60 0 0
Lending to SDA farmers and ranchers (3%) 31.90 0 0
Direct loan delinguency rate (3%) 8.30 0 0
Guaranteed loan delinquency rate (%%) 2.00 0 0
Primary loan zervicing processing time (%) 60 0 0

Part D. ADDITIONAL REVIEWS (Mandatory to be completed within first quarter following the review)
1. Farm Loan Program Risk Assessment (FLPRA) Reviews

[ This Review Area is not applicable for this reporting peri

1. Date of FLPRA Review by State Office
2. Date findings were discussed with FLF staff

There are no files to review.

Part D. ADDITIONAL REVIEWS (Mandatory to be completed within first quarter following the review)
2. County Operations Reviews (COR)

[¥ This Review Area is not applicable for this reporting per

1. Date of OOR Review
2. Date findings were discussed with FLF staff

There are no files to review.
Part E. CERTIFICATION District Director Signature

1. Distnct Director Signature
2. Name of Distnct Direcor
3. Date
(1 (2) 3
It 01/30/2012
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(Par. 442, 443)
DD FLP Oversight Review User Guide (Continued)

I Example of Completed Oversight Report (Continued)

Report Generated On: 72202013

Comments and Action Items Report

First Quarter Report
1.5TATE 2.DISTRICT NUMBER 3.5ERVICE CENTER 4 FISCAL YEAR
D- Semvice Center 2012
(uarterly Review » Direct Loan Making » Review Of Direct Loan Applications » Withdrawn Applicatit
File Reviews » ’ "|Record)
Comment

Z2nd letter should have been dated and mailed on 11/22. Actually dated 11/23. 1st |etter dated 11/02

(uarterly Review » Direct Loan Making » Review Of Direct Loan Applications » Withdrawn Applicatit
File Reviews » ” » A Complete Application Was Received? (Review ltem)

Response

Mo

Comment
Application withdrawn.

(Quarterly Review » Direct Loan Making » Review Of Direct Loan Applications » Withdrawn Applicati
File Reviews » » A Complete Application Was Received? (Review ltem)

Response

Mo

Comment

Complete Application was not receied.

(uarterly Review » Direct Loan Making » Review Of Direct Loan Applications » Withdrawn Applicati
File Reviews » _ __ {Record)

Comment
Applicant is now working on a new application.

Quarterly Review » Direct Loan Making » Review Of Direct Loan Applications » Withdrawn Applicatit
File Reviews » » A Complete Application Was Received? (Review ltem)

Response

Mo

Comment

Applicant did not provide all requested information.

(Quarterly Review & Direct Loan Servicing » Delinquent Account Servicing » Borrowers With Loans 9
Days Or More Past Due » ~ . Enter Anticipated Resolution |(Review ltem)

Response

8- Other: enter explanation in comments
Comment

Borrower will not return calls. Field visit planned.

(Quarterly Review » Direct Loan Servicinn » Delinquent Account Servicing » Borrowers With Loans 9
Days Or More Past Due & {Record)

C omment
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(Par. 442, 443)

DD FLP Oversight Review User Guide (Continued)

I Example of Completed Oversight Report (Continued)

F.eport Print Page Page7 of &

Borrower waiting on sales of wheat crop stored in grain bin. Barrower should pay current.

CQuarterly Review » Direct Loan Servicing » Delinquent Account Servicing » Borrowers With Loans 9
|Days Or More Past Due & (Record)

Comment
Paid current at time of review.

Quarterly Review » Direct Loan Servicing » Delinquent Account Servicing » Borrowers With Loans 9
|Days Or More Past Due & ) » Enter Anticipated Resolution {Review ltem)

Response

B- Other: enter explanation in comments
Comment

Borrower may request restructuring.
CQuarterly Review » Direct Loan~ Sarvicing » Delinquent Account Servicing » Borrowers With Loans 9
|Days Or More Past Due » __ k PLS History Report Indicates A PLS Notice Was Sent Within 1
Calendar Days Of Borrower's Account Becoming 90 Days Past Due. (Review ltem)

Response

Mo

Comment

Payment recieved prior to past due. $40.00,UCC 1 filing fee to 305, This is a no-monitary default. FLM is processing a
requestto STO stating that this is non-recoverable.

CQuarterly Review » Direct Loan Servicing » Delinquent Account Servicing » Borrowers With Loans 9
|Days Or More Past Due » » Enter Anticipated Resolution (Review ltem)

Response

B- Other: enter explanation in comments
Comment

Applicant paid loan off. UCC 1 filing fee of 40.00 is owed due to filing with 303 taking place prior to payoff of loan. Applica
has been notified of payment due.

CQuarterly Review » Direct Loan Servicing » Delinquent Account Servicing » Borrowers With Loans
|Less Than 90 Days Past Due » _» Anticipated Resolution (Review ltem)

Response

Borrower to pay account current.

Comment

Paid Current

CQuarterly Review » Direct Loan Servicing » Delinquent Account Servicing » Borrowers With Loans
Less Than 90 Days Past Due » __ » Delinquency Can Be Resolved Before Account
Enters 90 Days Past Due (Review ltem)

Response

Mo

Comment

Borrower pays late.

CQuarterly Review » Direct Loan Servicing » Delinquent Account Servicing » Borrowers With Loans
Less Than 90 Days Past Due w » Delinquency Can Be Resolved Before Account
Enters 90 Days Past Due (Review ltem)

L
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(Par. 442, 443)
DD FLP Oversight Review User Guide (Continued)

I Example of Completed Oversight Report (Continued)

F.eport Print Page Page 8 of @

Response

[

Comment
Borrower pay s late

Quarterly Review » Direct Loan Servicing » Delinquent Account Servicing » Borrowers With Loans
Less Than 90 Days Past Due » » Anticipated Res olution (Review ltem)

Response

Borrower to pay account current.
Comment

Paid Current

Quarterly Review » Direct Loan Servicing » Delinquent Account Servicing » Borrowers With Loans
Less Than 90 Days Past Due » + Anticipated Resolution (Review ltem)

Response

Baorrower to pay account current.
Comment

Paid Current

Quarterly Review » Direct Loan Servicing » Delinquent Account Servicing » Borrowers With Loans
Less Than 90 Days Past Due » . » Anticipated Resolution (Review ltem)

Response

Borrower to pay account current.
Comment

Paid Current

Quarterly Review » Direct Loan Servicing » Delinquent Account Servicing » Borrowers With Loans
Less Than 90 Days Past Due » _» Delingquency Can Be Resolved Before Account
Enters 90 Days Past Due (Review Item)

Response

Mo

Comment

Borrower alway s pays late. FLO will follow up.

Quarterly Review » Direct Loan Servicing » Delinquent Account Servicing » Borrowers With Loans
Less Than 90 Days Past Due » * Delinquency Can Be Resolved Before Account
Enters 90 Days Past Due (Review Item)

Response

Mo

Comment

Borrower alway s pays late. Last year offset gov. travel.

CQuarterly Review & Direct Loan Servicing » Delinquent Account Servicing » Borrowers With Loans
Less Than 90 Days Past Due » " w Delinquency Can Be Rescolved Before Account
Enters 90 Days Past Due (Review Item}

Response
Ma
Comment
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DD FLP Oversight Review User Guide (Continued)

I Example of Completed Oversight Report (Continued)

F.eport Print Page Paged of &

FLO to follow up with borrower.

CQuarterly Review » Direct Loan Servicing » Delinquent Account Servicing » Borrowers With Loans
That May Require Attention » . . _{Record)

Comment
Graham indicated payment had been mailed.

CQuarterly Review » Direct Loan Servicing » Delinguent Account Servicing » Borrowers With Loans
That May Require Attention b _ » Payments Are Being Made And Are Current
According To An Approved Plan Or Agreement {Review ltem)

Response

R [

Comment

011G conducting review.

Quarterly Review » Direct Loan Servicing » Delinquent Account Servicing » Borrowers With Loans
That May Require Attention » » Payments Are Being Made And Are Current
According To An Approved Plan Or Agreement (Review ltem)

Response

Mo

Comment

Case referred to WDC.

CQuarterly Review & Direct Loan Servicing » Delinquent Account Servicing » Borrowers With Loans

That May Require Attention » ) . Payments Are Being Made And Are Current Accordil
To An Approved Plan Or Agreement (Review ltem)

Response

Mo

Comment

Collection actions underway. Cattle to be picked up.

CQuarterly Review » Direct Loan Servicing » Delinquent Account Servicing » Borrowers With Loans
[That May Require Attention » » Payments Are Being Made And Are Current
According To An Approved Plan Or Agreement {Review ltem)

Response

Mo

Comment

Collection actions underway. Cattle to be picked up and sold.

Quarterly Review » Direct Loan Servicing » Delinquent Account Servicing » Borrowers With Loans
That May Require Attention (Record)

Comment
In process liquidating security.
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